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Preface

About This Guide

This guide describes how to install RSA Registration Manager. It is intended for 
administrators and other trusted personnel. Do not make this guide available to the 
general user population.

RSA Registration Manager Documentation

For more information about Registration Manager, see the following documentation:

Readme. Provides information about what is new and changed in this release, as 
well as workarounds for known issues. The latest version of the Readme is 
available from RSA SecurCare Online: https://knowledge.rsasecurity.com.

Installation Guide. Describes detailed procedures on how to install and initially 
configure RSA Registration Manager.

Administrator’s Guide. Describes the operation and administration of 
RSA Registration Manager.

Vettor’s Guide. Provides information for your Vettors about how to issue 
certificates and manage certificate status in RSA Registration Manager.

RSA Registration Manager Help. Describes day-to-day administration tasks 
performed through the administrative interface. To view the Help, click Help in 
the administrative interface.

Related Documentation

For more information about products related to Registration Manager, see the 
following:

RSA Certificate Manager documentation set. The full documentation set for 
RSA Certificate Manager is included in the \Documentation directory of the 
RSA Certificate Manager CD.
Preface 7
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Getting Support and Service

RSA SecurCare Online offers a knowledgebase that contains answers to common 
questions and solutions to known problems. It also offers information on new releases, 
important technical news, and software downloads.

The RSA Solutions Gallery provides information about third-party hardware and 
software products that the Secured by RSA Certified Partner Program has certified to 
work with RSA products. The directory includes Implementation Guides with 
step-by-step instructions and other information about interoperation of RSA products 
with these third-party products.

Before You Call Customer Support

Make sure you have direct access to the computer running the RSA Registration 
Manager software.

Please have the following information available when you call:

 Your RSA Customer/License ID. You can find this number on the license 
certificate that shipped with the product or on the label of the license CD, as 
applicable.

 RSA Registration Manager software version number and build number.

 The make and model of the machine on which the problem occurs.

 The name and version of the operating system under which the problem occurs.

RSA SecurCare Online https://knowledge.rsasecurity.com

Customer Support Information www.rsa.com/support

RSA Solutions Gallery www.securedbyrsa.com
8 Preface
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1 System Requirements

This chapter describes the minimum system requirements for an RSA® Registration 
Manager installation. 

Except for installation and server start and stop procedures, Registration Manager is 
displayed and behaves in the same manner on Microsoft Windows, Sun Solaris, 
Red Hat Enterprise Linux, and SUSE Linux Enterprise platforms.

Minimum System Configuration on Windows

On Windows Server 2003:

• One of the following operating systems:

– Windows Server 2003 with Service Pack 2

– Windows Server 2003 R2 with Service Pack 2

• Pentium III 650 MHz

• At least 256 MB of memory (RAM)

• Hard disk with at least 60 MB of free space for basic program installation
Additional space may be required for database storage. Each certificate requires 
between 256 bytes and 4 KB of disk space, depending on the type of cryptography 
and the number of extensions used.

On Windows Server 2008 32-bit:

• Windows Server 2008 32-bit with Service Pack 1

• Intel Pentium 4 CPU 2.53GHz 2.52 GHz

• At least 1.50 GB of memory (RAM)

• Hard disk with at least 150 MB of free space for basic program installation 
Additional space may be required for database storage. Each certificate requires 
between 256 bytes and 4 KB of disk space, depending on the type of cryptography 
and the number of extensions used.
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On Windows Server 2008 64-bit:

• One of the following operating systems:

– Windows Server 2008 64-bit with Service Pack 1

– Windows Server 2008 R2 64-bit with Service Pack 1

• Intel Core2 Duo processor @2.80GHz 2.79 GHz

• At least 4.00 GB of memory (RAM)

• Hard disk with at least 150 MB of free space for basic program installation 
Additional space may be required for database storage. Each certificate requires 
between 256 bytes and 4 KB of disk space, depending on the type of cryptography 
and the number of extensions used.

Minimum System Configuration on Solaris

• Sun Solaris 10

• Sun Enterprise Ultra 10S or equivalent

• At least 300 MB of memory (RAM)

• Hard disk with at least 85 MB of free space for basic program installation
Additional space may be required for database storage. Each certificate requires 
between 256 bytes and 4 KB of disk space, depending on the type of cryptography 
and the number of extensions used.

Minimum System Configuration on Linux

• One of the following operating systems:

– Red Hat Enterprise Linux 4 or 5, 32-bit

– Red Hat Enterprise Linux 5.5, 32-bit or 64-bit

– SUSE Linux Enterprise Server 11 Service Pack 1, 32-bit or 64-bit 

• Intel Pentium 4 or equivalent

• At least 300 MB of memory (RAM)

• Hard disk with at least 100 MB of free space for basic program installation
Additional space may be required for database storage. Each certificate requires 
between 256 bytes and 4 KB of disk space, depending on the type of cryptography 
and the number of extensions used.
10 1: System Requirements
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Support on VMware ESX Server 4.1

RSA Registration Manager is supported on VMware ESX Server 4.1 on the following 
platforms:

• Windows Server 2003 with Service Pack 2

• Windows Server 2003 R2 with Service Pack 2

• Windows Server 2008 32-bit with Service Pack 1 

• Windows Server 2008 64-bit with Service Pack 1 

• Windows Server 2008 R2 64-bit with Service Pack 1

• Red Hat Enterprise Linux 5.5, 32-bit or 64-bit

• SUSE Linux Enterprise Server 11 Service Pack 1, 32-bit or 64-bit

Registration Manager supports the following features on VMware ESX Server 4.1:

• Cloning

• Snapshots

• Physical to Virtual (P2V) conversion

Registration Manager has been tested with network-based hardware security modules 
(HSMs), such as SafeNet Luna and nCipher netHSM, with guest operating systems 
running on VMware ESX Server 4.1. Registration Manager was not tested with 
PCI-based or SCSI-based HSMs.

Browser Support for Administration

Registration Manager supports web-based administration with the following 
browsers:

• Microsoft Internet Explorer 6.0 to 9.0 with JavaScript and UTF-8 encoding 
enabled

• Mozilla Firefox 2.0 to 3.6.13 with JavaScript and UTF-8 encoding enabled

• Mozilla 1.7 with JavaScript and UTF-8 encoding enabled

Browser Settings

You must enable JavaScript and UTF-8 encoding for web-based administration. If you 
do not enable both, some pages of Registration Manager may not be displayed 
properly.

In Internet Explorer

1. To enable JavaScript:

a. Click Tools > Internet Options, and click the Security tab.

b. Select the appropriate web content zone.
If you are not sure which zone to select, you can enable JavaScript for all of 
the following zones: Internet, Local intranet, and Trusted sites.
1: System Requirements 11
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c. Select the Security level for the zone.
If you are using the default security level, JavaScript is enabled. (JavaScript is 
enabled at the Low, Medium-low, and Medium levels.)
If you are using a custom security level, click Custom Level. Scroll down to 
Scripting > Active Scripting, and select Enable.

2. To enable UTF-8 encoding, do one of the following:

• In Internet Explorer 6.x, click View > Encoding > Unicode (UTF-8), and 
clear Auto-Select.

• In Internet Explorer 7.0 to 9.0, click Page > Encoding > Unicode (UTF-8), 
and clear Auto-Select.

In Firefox

1. To enable JavaScript, do one of the following:

• On Windows, click Tools > Options, and, on the Content tab, select 
Enable JavaScript.

• On Linux, click Edit > Preferences, and, on the Content tab, select 
Enable JavaScript.

2. To enable UTF-8 encoding, click View > Character Encoding > 
Unicode (UTF-8). You may want to set this as your default character set.

In Mozilla

1. To enable JavaScript:

a. Click Edit > Preferences > Advanced > Scripts & Plug-ins.

b. Under Enable JavaScript for, select Navigator.

c. Under Allow scripts to, select all options except Hide the status bar.

2. To enable UTF-8 encoding, click View > Character Encoding > 
Unicode (UTF-8). You may want to set this as your default character set.

Entering and Displaying International Characters

On Windows

To enter and display international characters in certificates, use Input Method Editors 
(IMEs).

To enable IMEs: 

• On Windows 2003, Windows XP, or Windows Vista, in the Control Panel, enable 
the relevant IMEs through Regional and Language Options.

• On Windows Server 2008 or Windows 7, in the Control Panel, enable the relevant 
IMEs through Clock, Language, and Region.

On Solaris

To enter and display international characters in certificates, edit or add the relevant 
LANG, LC_CTYPE, and LC_COLLATE variables in the /etc/default/init file.
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On Red Hat Linux

To enter and display international characters in certificates, edit or add the relevant 
LANG, SUPPORTED, and SYSFONT variables in the /etc/sysconfig/i18n file.

On SUSE Linux

To enter and display international characters in certificates, edit or add the relevant 
LANG, LC_ TYPE, and LC_COLLATE variables in the /etc/sysconfig/language file.

Browser Support for Enrollment

Registration Manager supports web-based enrollment with the following browsers:

• Microsoft Internet Explorer 4.0 to 9.0

• Mozilla Firefox 2.0 to 3.6.13

• Mozilla 1.7

Hardware Security Module Support

Registration Manager supports the use of a PKCS #11-compliant hardware security 
module (HSM) for protecting the private keys of servers. For more information on 
HSMs, see Appendix A, “Cryptographic Hardware Interoperability.”

HSMs increase the physical security of server private keys in public key management 
applications. Smart cards can be removed from the computer for portability and secure 
storage.
1: System Requirements 13
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2 Installing RSA Registration Manager

This chapter describes the standard RSA Registration Manager installation process. 
The topics covered are:

• Pre-installation checklist

• Preparing to install

• Installing the setup files

• Browser-based phase of the installation

• Post-installation tasks

• Starting Registration Manager

• Failover

Registration Manager works with target Jurisdictions that are part of an 
RSA Certificate Manager installation. A target Jurisdiction is a specific Jurisdiction 
for which Registration Manager vets certificate requests and issues certificates. The 
target CA installation is the installation of Certificate Manager where the CAs of the 
target Jurisdictions reside. Many CAs can reside at an installation and each CA can 
have many Jurisdictions. You install Registration Manager against one target 
Jurisdiction. You can add and remove access to additional Jurisdictions after 
installation, but you cannot remove access to the initial target Jurisdiction. For more 
information, see the Administrator’s Guide.

The Registration Manager installation process has two phases:

• Install the setup files on a Windows, Solaris, or Linux platform.

• Use your browser to complete the installation.

If you are upgrading from a previous version of Registration Manager, see Chapter 3, 
“Upgrading RSA Registration Manager.”

Note: An evaluation copy of Certificate Manager has a license file that limits the 
number of certificates that can be stored in the Certificate Manager Secure Directory. 
During installation, Registration Manager requests 12 certificates from the target CA 
installation. You will encounter installation problems if these certificates cause 
Certificate Manager to exceed the licensed limit. For more information, see the 
RSA Certificate Manager Installation Guide.

Important: To use nCipher tokens with Registration Manager, install your token 
hardware and drivers before installing Registration Manager. You must also initialize 
the token before beginning the Registration Manager installation.
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Pre-Installation Checklist

Be sure to consider the following questions before you begin your Registration 
Manager installation.

System

• Does your system meet the minimum system requirements?
For more information, see “Minimum System Configuration on Windows” on 
page 9, “Minimum System Configuration on Solaris” on page 10, or “Minimum 
System Configuration on Linux” on page 10.

Browser

• What browser will you use?

– Microsoft Internet Explorer 6.0 to 9.0

If you are installing on a Windows platform, use Microsoft Internet Explorer 
for local installation and administration.

– Mozilla Firefox 2.0 to 3.6.13

– Mozilla 1.7

• If the browser is not local to the machine on which Registration Manager is being 
installed, does the browser have access to that machine?

Important: You cannot use Internet Explorer on Windows Vista for remote 
installation.

For more information, see “Browser Support for Administration” on page 11.

Failover

• If you are installing on a Solaris or Linux platform, do you want to install a 
standby machine to enable failover?

– If yes, you must modify the specified files before you begin the installation 
process.

For more information, see “RSA Registration Manager Failover” on page 36.

Cryptographic Provider

• Will you protect the server key pairs with a PKCS #11-compliant HSM?

– If yes, have you installed and set up the HSM?

Important: The PIN must not exceed 35 characters.

For more information, see “Private Key Protection” on page 63.
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Passphrase Protection

• If your SSL keys are software keys, will you protect them with a passphrase? You 
can change, add, or remove a passphrase after the installation is completed.

– If yes, choose a strong passphrase 4–35 characters long.

For more information, see the Administrator’s Guide.

Configuration Information

• Have you gathered the information that is required during the installation:

– target CA installation (the Certificate Manager installation that contains the 
initial Jurisdiction for which Registration Manager will manage certificates):

hostname (FQDN) ______________________________________________

non-secure LDAP port (default 389) _____________

secure LDAP port (default 636) _____________

– Registration Manager Administrator’s e-mail address

______________________________________________________________

– hostname of the Registration Manager installation

______________________________________________________________

– port numbers for all servers (use port numbers lower than 32767 and ensure 
the ports are not used by other applications):

Administration Server (default 444) _____________

Enrollment Server (default 443) _____________

Certificate Renewal Server (default (448) _____________

SCEP Server (default 446) _____________

Secure Directory Server (default 636) _____________

Directory Server (default 389) _____________

– Logging Server:

hostname ______________________________________________________

port number (default 5160) _____________

– active mail server:

hostname ______________________________________________________

port number _____________

– name of the target Jurisdiction _____________________________________

Important: Installation will fail if the CA of the target Jurisdiction uses 
SHA 256, SHA 384, or SHA 512 as its digest algorithm, or ECDSA or 
RSASSA-PSS as its signature algorithm.

– the passphrase or PIN of the CA of the target Jurisdiction, if the CA is in 
Prompt Every Time mode
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• Will you specify an Installation Name? RSA recommends that you use a name 
that uniquely identifies your installation.
_________________________________________________________________

For more information, see “Browser-Based Phase of the Installation” on page 24.

Media Verification

• Do you want to verify that the product CD has not been tampered with since it was 
signed by RSA?
For more information, see Appendix C, “Media Verification.”

Preparing to Install

Before you install Registration Manager, complete the following tasks:

• Install the RSA BSAFE® SSL-C 2.8.5.1 library files. See “Installing RSA BSAFE 
SSL-C Library Files” on page 18.

• Enable SSL 3.0 and TLS 1.0 in your browser. See “Enabling SSL 3.0 and TLS 
1.0” on page 19.

• If you are using nCipher PKCS #11 keys, configure the nCipher PKCS #11 
provider. See “Configuring the nCipher PKCS #11 Provider” on page 19.

• If you are using Internet Explorer 8 or 9 to install Registration Manager on 
Windows Server 2008, configure required browser settings. See “Configuring 
Internet Explorer 8 or 9 Settings” on page 20.

Installing RSA BSAFE SSL-C Library Files

You must install the RSA BSAFE SSL-C 2.8.5.1 library files, which are on the 
product CD.

To install RSA BSAFE SSL-C library files:

1. Extract the RSA BSAFE SSL-C 2.8.5.1 library files from the appropriate .zip or 
.tar file:

• On Windows, SSLC_CryptoCME_Libs-WIN32.zip

• On Solaris, SSLC_CryptoCME_Libs-sparc-sun-solaris.tar

• On Red Hat Linux, SSLC_CryptoCME_Libs-RH_Linux.tar

• On SUSE Linux, SSLC_CryptoCME_Libs-SuSE_Linux.tar

2. Copy the extracted contents to the appropriate location:

• On Windows Server 2003 32-bit or Windows Server 2008 32-bit, 
C:\Windows\system32

• On Windows Server 2008 64-bit, C:\Windows\SysWOW64

• On Solaris, Red Hat Linux, or SUSE Linux, /usr/lib

Note: Make sure that you log on as the root user and give proper permissions 
to the users to access the libraries.
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Enabling SSL 3.0 and TLS 1.0

To enable SSL 3.0 and TLS 1.0 in Internet Explorer:

1. Click Tools > Internet Options.

2. On the Advanced tab, from the Settings list, under Security, select Use SSL 3.0 
and Use TLS 1.0.

To enable SSL 3.0 and TLS 1.0 in Firefox:

1. Click Tools > Options > Advanced.

2. On the Encryption tab, select Enable SSL 3.0 and Enable TLS 1.0.

To enable SSL 3.0 and TLS 1.0 in Mozilla:

1. Click Edit > Preferences.

2. In the left-hand pane, expand Privacy & Security and click SSL.

3. Select Enable SSL version 3.

4. Click OK.

Configuring the nCipher PKCS #11 Provider

To configure the nCipher PKCS #11 provider on Windows:

1. Set the environmental variable NFAST_HOME to C:\nfast.

2. Ensure that the nCipher PKCS #11 library is available at C:\nfast\bin\cknfast.dll.

3. To generate SSL PKCS #11 keys, in the C:\nfast\cknfastrc file, set the following 
variables:

• CKNFAST_NO_ACCELERATOR_SLOTS= 1

• CKNFAST_ASSUME_SINGLE_PROCESS=0

Note: Use the CKNFAST_ASSUME_SINGLE_PROCESS variable only for 
installation of Registration Manager. After the installation is complete, 
remove this flag from the cknfastrc file because the flag may slow down the 
performance of Registration Manager.

• CKNFAST_OVERRIDE_SECURITY_ASSURANCES= import

4. Restart the nCipher services.

5. Verify nCipher PKCS #11 key generation by using the ckcheckinst.exe utility in 
the C:\nfast\bin directory.

Note: Slot 0 is a virtual slot. Slot 1 is a configured token slot. Certificate Manager 
uses slot 1 for nCipher PKCS #11 key generation. The accelerator slot, which is 
slot 0, should be removed from nCipher configuration.

6. Verify that the nCipher slot is assigned to slot 0 by using the ckinfo.exe utility.

Note: nCipher PKCS#11 SSL keys support a 1of N persistent card set.
2: Installing RSA Registration Manager 19
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To configure the nCipher PKCS #11 provider on Solaris or Linux:

1. Set the environmental variable NFAST_HOME to /opt/nfast.

2. Ensure that the nCipher PKCS #11 library is located at 
/opt/nfast/toolkits/PKCS11/libcknfast.so.

3. To generate SSL PKCS #11 keys, in the /opt/nfast/bin/cknfastrc file, set the 
following variables:

• CKNFAST_NO_ACCELERATOR_SLOTS= 1

• CKNFAST_ASSUME_SINGLE_PROCESS=0

Note: Use the CKNFAST_ASSUME_SINGLE_PROCESS variable only for 
installation of Registration Manager. After the installation is complete, 
remove this flag from the cknfastrc file because the flag may slow down the 
performance of Registration Manager.

• CKNFAST_OVERRIDE_SECURITY_ASSURANCES= import

4. Restart the nCipher services.

5. Verify nCipher PKCS #11 key generation by using the ckcheckinst utility in the 
/opt/nfast/bin/ckcheckinst directory.

Note: Slot 0 is a virtual slot. Slot 1 is a configured token slot. Certificate Manager 
uses slot 1 for nCipher PKCS #11 key generation. The accelerator slot, which is 
slot 0, should be removed from nCipher configuration.

6. Verify that the nCipher slot is assigned to slot 0 by using the ckinfo utility in the 
/opt/nfast/bin directory.

Note: nCipher PKCS #11 SSL keys support a 1of N persistent card set.

Configuring Internet Explorer 8 or 9 Settings

To install Registration Manager using Internet Explorer 8 or 9 on Windows 
Server 2008 or Windows 7, you must set the following browser settings to enable 
Registration Manager to request and install the Administrative certificate during the 
browser-based phase of the installation.

To configure Internet Explorer on Windows Server 2008 or Windows 7:

1. Click Tools > Internet Options.

2. On the Security tab, click Trusted sites > Sites.

3. Add the Registration Manager host to the list of trusted sites.

4. In Internet Explorer 9 only, on the Advanced tab, in the Settings list, under 
Security, ensure that Do not save encrypted pages to disk is cleared.

5. Click Apply, and click OK.
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Important: When you are using Internet Explorer 8 or 9 on Windows Server 2008 or 
Windows 7, if the Web Access Confirmation pop-up window prompts you to allow 
digital certificate operations, click Yes.

Installing RSA Registration Manager on Windows

The Windows version of Registration Manager consists of both a zipped and an 
uncompressed distribution of setup files.

Prerequisites

• Perform the tasks in “Preparing to Install” on page 18.

• Ensure that you have Windows Administrator privileges.

• If you are using Internet Explorer with Enhanced Security Configuration enabled 
on a Windows platform, add the Registration Manager host to the browser Local 
intranet or Trusted sites list. If the server is not added to one of these lists, you 
cannot complete the browser-based phase of the installation.

• If you are using Internet Explorer 7, from the Certificate Manager Enrollment 
Server, install the certificate chain of the CA of the initial target Jurisdiction. If 
you do not install the CA certificate chain, you cannot complete the 
browser-based phase of the installation.

To begin the installation process:

1. Unzip RSARM-v6.9build551r-WIN32.zip to a temporary directory.

2. Run setup.exe, either directly from the \uncompressed directory or from a 
temporary directory to which you have unzipped the zipped files. (Your version of 
unzip or WinZip must support long filenames.)

3. Do one of the following:

• To use your computer’s default browser for installation and administration, 
select Use Default Browser and click Next.

• To use another browser:

a. Select Use Other Browser and click Next.

b. Select the browser that you want to use.

4. Select New Install and click Next.

5. When prompted to select cryptographic providers for use with Registration 
Manager, do one of the following:

• If the certificates created during installation will be either software-based or 
use an nCipher HSM, select Do not search and click Next.
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• If you are using a PKCS #11 cryptographic provider and have already 
installed the HSM, select Search for cryptographic providers and click 
Next. When prompted:

a. Enter the path of the folder containing the cryptographic provider.

b. Enter the filename of the cryptographic provider.

c. From the list of found providers, select the cryptographic provider that 
you want to use.

6. Select the directory where you want to install Registration Manager and click 
Next.
Wait while the installation wizard copies files to the installation directory, and 
then configures and starts the services that install Registration Manager (the 
Installation Directory Server and the Installation Web Server). This process takes 
a few minutes.

7. Write down the URL that is displayed, and click Finish to launch your browser 
and complete the installation.
If your browser does not automatically connect to the End User License 
Agreement page, open a browser session and enter the URL that you recorded.

8. To complete the installation, see “Browser-Based Phase of the Installation” on 
page 24.

Installing RSA Registration Manager on Solaris or Linux

The Solaris and Linux versions of Registration Manager consist of a compressed tar 
distribution of setup files.

Prerequisite

• Perform the tasks in “Preparing to Install” on page 18.

• Registration Manager must be installed by the “root” user or a member of the 
nfast group to allow operation with nCipher cryptographic hardware. If you install 
as “root”, in step 12 of “Browser-Based Phase of the Installation” you must 
specify a user other than “root” to run the Web Server as. This user must also 
belong to the nfast group.
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To begin the installation process:

1. Copy the Registration Manager tar file, 
RSARM-v6.9build551r-sparc-sun-solaris.tar, 
RSARM-v6.9build551r-linux.tar, or RSARM-v6.9build551r-SuSE_linux.tar 
depending on your platform, from the CD to the directory where you want to 
install Registration Manager.

Important: If you install in a directory where the permissions are overly 
restrictive (such as the /root directory on Linux or a locked-down directory on 
Solaris or Linux), you may not be able to complete the installation. When you 
click Next at step 16 of “Browser-Based Phase of the Installation,” you may see 
an access error message and the default ACL rules may not be applied. If this 
happens, contact RSA Customer Support.

2. Untar the file.
Where you untar the setup files is where Registration Manager is installed. You 
cannot select a different directory path at a later step in the installation.

3. Change directories to the /RSA_RM directory and run the INSTALL script.

4. When prompted to indicate whether this is a new installation or an upgrade, press 
1 and Enter.

5. When prompted to configure Registration Manager to use installed cryptographic 
providers, do one of the following:

• If the certificates created during installation will be either software-based or 
use an nCipher HSM, press 2 and Enter to skip the search, and go to step 8.

• If you are using a PKCS #11-compliant HSM, press 1 and Enter to search for 
cryptographic providers. 

6. When prompted to search for the PKCS #11 provider library, do one of the 
following:

• If you have installed the hardware, drivers, and firmware, and you want to add 
support for this installation, press 1 and Enter to search for the library. 

• If you do not want to add support, press 2 and Enter to skip the search, and go 
to step 8.

7. If the PKCS #11 provider library is not in a default directory, follow these steps:

a. Enter additional directories to search.

b. To begin searching for the library, press Enter.

c. Enter the name of the PKCS #11 provider library and press Enter. 
You can use the wildcard character * to represent any string of characters.

d. To select the library from the list of found libraries, press the corresponding 
number and press Enter.
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8. When the INSTALL script finishes, use your web browser to connect to the URL 
indicated in the final output of the script. The URL begins with “https”.
After this phase of the installation is complete, the services that install 
Registration Manager (the Installation Web Server and the Installation Directory 
Server) are started.

9. To complete the installation, see the following section, “Browser-Based Phase of 
the Installation.”

Browser-Based Phase of the Installation

The browser-based phase of the installation process is identical on Windows, Solaris, 
and Linux platforms. This phase completes the installation process and configures 
Registration Manager. Once the browser-based phase of the installation is complete, 
Registration Manager is fully functional.

Prerequisites

• You must have Administrator access to the target CA installation. If you do not 
have Administrator access to Certificate Manager, some of the following steps 
must be performed by a Certificate Manager Administrator.

• The following table describes conditions that will cause the installation to fail. If 
any of these conditions exist, use the appropriate workaround.

Condition Workaround

The Registration Manager server’s time 
is running late compared to the 
Certificate Manager server’s time. (The 
certificates issued by Certificate 
Manager to Registration Manager will 
not yet be valid at the Registration 
Manager installation.)

Synchronize the system time on the server 
where you are installing Registration Manager 
with the system time at the Certificate 
Manager installation.

The initial target Jurisdiction has DN 
attributes that are required but have no 
default value and has Enforce DN 
Definition turned on.

A Certificate Manager Administrator can 
temporarily change the DN configuration of 
the target Jurisdiction (by providing default 
values or by turning off Enforce DN 
Definition) to allow installation of 
Registration Manager.

The CA of the initial target Jurisdiction 
uses SHA 256, SHA 384, or SHA 512 
as its digest algorithm, or ECDSA or 
RSASSA-PSS as its signature 
algorithm.

Target the Jurisdiction of another CA during 
installation. After you complete the 
installation, you can add access to the 
Jurisdiction of the CA that uses SHA 256, 
SHA 384, or SHA 512, or ECDSA or 
RSASSA-PSS.
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• If the Registration Manager server certificates are issued by a target Jurisdiction 
that has DN encoding set to UTF8_STRING_ONLY, end users will be unable to 
access the Enrollment Server. A Certificate Manager Administrator can 
temporarily set the DN encoding to either PRINTABLE_WITH_UTF8_STRING 
or PRINTABLE_WITH_BMP_STRING to issue the Registration Manager server 
certificates.

To complete the installation process:

Note: When you launch your browser to complete this phase of the installation, you 
may be prompted to trust the authority that issued this secure site’s certificate. You 
must agree to trust it in order to proceed. If the issuing authority’s trusted root 
certificate is already installed in your browser, you are not prompted.

1. Read the End User License Agreement and click Accept to accept the End User 
License Agreement.
If you are using Internet Explorer 8 or 9 on Windows Server 2008 or Windows 7, 
when prompted to allow digital certificate operations, click Yes.
The RSA Registration Manager Installer page opens. The top part of this page is 
the Target CA Information section.

Note: Click the underlined blue text to open a new browser window that displays 
the installation glossary. This new window may cover the installer window. To 
return to the installer, exit the glossary by clicking X in the upper right corner of 
the browser window.

If you do not want to accept the End User License Agreement, close the browser 
window and terminate the installation.

2. Enter the hostname and non-secure port number of the target CA installation, as 
gathered in “Configuration Information” on page 17.
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Note: If you enter incorrect host and port information here, or if the target CA 
installation is unavailable, you encounter a XUDAUNABLE error when you click 
Make Certificate Requests in step 6. If this happens, you can use the browser 
Back button to return to this page and enter correct values for the hostname and 
port numbers.

The bottom part of the RSA Registration Manager Installer page is the SSL 
Certificate Information section. The top part of the SSL Certificate Information 
section contains user information fields.

3. Enter an Installation Name, Company, Department, and Country.
The values entered here can uniquely identify the installation. The Installation 
Name is incorporated into the Common Name of the Administrative certificate, 
which is Installation Name RM Administrative certificate. The values in the 
Company, Department, and Country fields are used in the DN of the Web Server 
certificates. All fields are optional and can be left blank. RSA recommends that 
you enter at least an Installation Name.
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4. In the bottom part of the SSL Certificate Information area, specify the 
cryptographic providers and key sizes for the SSL keys and administrator 
certificate keys. Do one of the following:

• If your cryptographic provider is software-based, you see the following 
screen. Select the key size for each type of key and the cryptographic provider 
for the administrator certificate keys, and click Next.
The larger the key size, the harder it is to break the key and the greater the 
security.

• If you have installed nCipher, you see the following screen. Select the 
cryptographic provider and key size for each type of key, and click Next.
The larger the key size, the harder it is to break the key and the greater the 
security.

Another RSA Registration Manager Installer page opens.
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5. Depending on whether your SSL keys are software- or hardware-based, do one of 
the following:

• If your SSL keys are software-based and you want to passphrase-protect the 
SSL keys, enter a passphrase and click Next.
If you leave the passphrase fields blank, the SSL keys are not protected by a 
passphrase.

• If your SSL keys are protected by a PKCS #11-compliant HSM, enter the slot 
number and click Next.

Enter the PIN that accesses the smart card and click Next. 

Another RSA Registration Manager Installer page opens.

6. Click Make Certificate Requests.
The Installation Web Server generates the certificate requests and sends them to 
Certificate Manager. For more information on the certificates being requested, see 
“Issued Certificates” on page 52.

Important: This process may take a few moments. Wait until the Making SSL 
Certificate Requests page opens.
28 2: Installing RSA Registration Manager



RSA Registration Manager 6.9 Installation Guide
7. When you see a message that the certificate requests have been sent, click Next.
The SSL Certificate Retrieval page opens.

8. Pause in the Registration Manager installation until the Registration Manager 
certificates are issued and the LDAP access control rules are modified at the target 
CA installation.
In your browser, you can bookmark the SSL Certificate Retrieval page and return 
to it after the certificates have been issued by Certificate Manager.
The URL for this page is 
https://host.subdomain.com:installation port number/retrieve.html.

9. Issue the SSL certificates from Certificate Manager:

Note: If you do not have Administrator access to Certificate Manager, a 
Certificate Manager Administrator must perform these steps.

If you can connect to the Certificate Manager Administration Server from the 
machine where you are installing Registration Manager, open a new browser 
session before proceeding in Certificate Manager.

a. Connect to the Administration Server of the Certificate Manager installation.

b. Click Administrator Operations and, from the Installation drop-down list, 
select request-active.
The Registration Manager certificate requests are grouped into a single item 
in the list of active certificate requests.

c. Click the RSA Registration Manager certificate request hyperlink.
The Registration Manager certificate request opens. Only one request must be 
vetted to issue all Registration Manager certificates.

d. On the Request page, click Issue Certificate.
You see a message that the e-mail address appears to be invalid and e-mail 
will not be sent. Click OK. (The Registration Manager server certificates are 
retrieved by the Registration Manager installer.)
The System CA issues the certificates. This process may take a few moments.
The RSA Registration Manager Installation page opens.
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e. Provide a nickname that uniquely identifies the Registration Manager 
installation.

f. From the drop-down list, select the target Jurisdiction. 
Only the Jurisdictions of active CAs are displayed in the drop-down list.

g. Click Apply LDAP ACL Rules.
The LDAP ACL rules are modified to give Registration Manager write access 
to the CA’s request queue and signing engine.

h. When you see a message that the LDAP ACL rules have been modified, click 
Close.
Certificate Manager is now configured to support the new Registration 
Manager installation.

10. Return to the SSL Certificate Retrieval page in the Registration Manager 
Installation Web Server where you paused in step 8 and click Retrieve SSL 
Certificates.
The Installation Web Server connects to Certificate Manager and retrieves the 
Registration Manager certificates.

11. On the Retrieving SSL Certificates page, click Proceed with Registration 
Manager Configuration.
The RSA Registration Manager Installation page opens.
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12. Verify the defaults that are displayed in the General Configuration Information 
against the information gathered in “Configuration Information” on page 17.
If you are installing Registration Manager on Solaris or Linux, User and Group 
fields are displayed and default values for these fields are provided. If you are 
installing as “root”, no defaults are displayed. Specify a user other than “root” and 
a group for the Web Server. If the installation uses nCipher cryptographic 
hardware, the user must be a member of the nfast group.
Edit the defaults if needed, and click Next.
A General Configuration Information page opens, with a message that there was 
no problem with the information provided.

13. From the drop-down list, select the same target Jurisdiction that the Certificate 
Manager Administrator selected in step 9 and click Next.
If you are using Microsoft Internet Explorer, you may be prompted to allow a 
certificate request to proceed. To proceed with the installation, click Yes.
The Configuration Complete page opens, with a message that all necessary 
information has been gathered.
At this point, Registration Manager sets up the Web Server, the Secure Directory 
Server, and the Logging Server.
The Server Setup page opens and displays the progress of the setup.

Important: This process takes a few moments. Wait until you see Done in the 
status bar of the Server Setup page.

If you see an error message, “Unable to contact directory server,” you selected a 
different target Jurisdiction than selected by the Certificate Manager 
Administrator. You must click the browser Refresh button and begin the 
browser-based phase of the installation again at step 1.
2: Installing RSA Registration Manager 31



RSA Registration Manager 6.9 Installation Guide
14. When Done is displayed in the status bar of the Server Setup page, scroll to the 
bottom of the page and click Continue.
If you are using Internet Explorer 8 or 9 on Windows Server 2008 or Windows 7, 
when prompted to allow digital certificate operations, click Yes.
The following page opens.

15. Install the RM Administrative certificate into your browser as follows:

a. Click Install Root CA Certificate to install the root CA certificate into your 
browser in the Trusted Root Certification Authorities store.

b. Click Install Client Certificate to install the RM Administrative certificate 
into your browser.

If prompted to allow the certificate to be added, click Yes. You see a message that 
certificate installation succeeded. Click OK to close the dialog box.
Some browsers do not confirm that the certificate has been successfully 
downloaded. Check the browser certificate store to ensure that the certificate has 
been downloaded.

16. Click Next.
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Note: When you connect to the Administration Server or the Enrollment Server, 
you may prompted to trust the authority that issued this secure site’s certificate. 
You must agree to trust it in order to connect to the server. (If the issuing 
authority’s trusted root certificate is already installed in your browser, you are not 
prompted.)

The Congratulations page opens. Registration Manager is now installed and ready 
for use.

Note: If you are using Internet Explorer 7 and you see a message that the content 
is blocked, install the certificate chain of the CA of the target Jurisdiction in your 
browser. To complete the installation:

a. From the Certificate Manager Enrollment Server, install the certificate chain 
of the CA of the Jurisdiction.

b. Open a new browser session and connect to 
https://host:admin-port/inst-forms/apply-acl.xuda.

17. Record the URLs for the various Web Server virtual hosts from the list.
You can connect to the Administration Server or the Enrollment Server by 
clicking the link provided. You must have the RM Administrative certificate that 
was downloaded in step 15 to access the Administration Server.

The Installation Web Server and the Installation Directory Server remain on your file 
system and can be removed at your discretion. For instructions, see Appendix B, 
“Uninstalling RSA Registration Manager.”
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Post-Installation Tasks

RSA recommends that you perform the following tasks immediately after installation:

• Create a full backup of the installation

• Configure database backups

• Configure the logging server

• Configure the PKI events to be logged

• Issue Administrator, Vettor, and Auditor certificates

• Reissue the Web Server certificates, signed by the root CA 
(this must be done at the Certificate Manager installation)

• Configure unattended startup

• Configure the cryptographic provider for signature verification

For more information, see the Administrator’s Guide.

Starting RSA Registration Manager on Windows Server 2003

To start Registration Manager:

Note: If you have more than one installation of Registration Manager on the same 
machine, a number is added to the service names of subsequent installations. For 
example, [02] is added to the end of each service name for the second installation.

1. Click Start > Programs > Administrative Tools > Services.

2. From the Services list, select RSA Secure Logging Server 6.9 and click Start.
Logging Server startup is not dependent on the startup of other services.

3. From the Services list, select RSA RM 6.9 build 551 (Secure Directory) and 
click Start.
The Secure Directory Server is required during startup of the Administration 
Server. If you attempt to start the Administration Server before the Secure 
Directory Server, the Secure Directory Server automatically starts first.

4. From the Services list, select RSA RM 6.9 build 551 (Administration) and click 
Start.
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Starting RSA Registration Manager on Windows Server 2008

On Windows Server 2008, for attended startup, you must start the services through the 
servicectrl utility. If you try to start the services from the Service Control Manager 
(services.msc), the service startup fails and an error message is logged in the Event 
Log. For unattended startup, you can start the service from either the Service Control 
Manager or through the servicectrl utility.

Prerequisite to Run servicectrl Utility

To run the servicectrl utility, you must have a built-in administrator account. If you 
have an administrator account that is not a built-in account, you can do one of the 
following and then run the servicectrl utility:

• Start the command prompt as Run as Administrator. You will be prompted for 
consent to get the full administrator privilege.

• Disable User Access Control (UAC) for your user account.

To disable UAC:

1. Click Start > Control Panel.

2. In the search field, type:

uac

and press Enter.
If you're prompted for an administrator password or confirmation, type the 
password or provide confirmation. 

3. On Windows Server 2008 (32-bit or 64-bit), follow these steps:

a. Click Turn User Account Control (UAC) on or off.

b. Clear Use User Account Control to help protect your computer, and click 
OK.

4. On Windows Server 2008 R2, follow these steps:

a. Click Change User Account Control settings.

b. Move the slider to the Never notify position, and click OK.

5. Restart the server.

To start RSA Registration Manager:

1. Open a command prompt, and change directories to installed-dir\Utils.

2. Do one of the following:

• To start all services, type:

servicectrl.exe start all

• To start a specific service, type:

servicectrl.exe start service

where service is Xudad, WebServer, or LogServer.
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Starting RSA Registration Manager on Solaris or Linux

To start Registration Manager:

1. Change directories to the directory where you installed Registration Manager.

2. At the command prompt, type:

./START

The Web Server, Secure Directory Server, and Logging Server all start.

You can also start only the Secure Directory Server without using the START script. If 
you do, you must specify the configuration file.

To start the Secure Directory Server only:

1. Change directories to the /installed-dir/Xudad/bin directory.

2. At the command prompt, type:

./xudad -f ../conf/xudad.conf

RSA Registration Manager Failover

For the Solaris and Linux platforms only, Registration Manager allows Administrators 
to bring a secondary instance of Registration Manager into full operation without 
operator assistance, while maintaining a level of security that meets FIPS 140-1 
level 3 compliance. This allows Registration Manager to be part of a system that 
provides failover capabilities.

You can configure Registration Manager to allow for a standby system. The associated 
HSMs must be cloned (see Appendix A, “Cryptographic Hardware Interoperability”) 
and the servers must share a disk as well as having their own local disk for storage.

To have a fully automated system, high availability or clustering software is required 
to detect the primary failure and enable the secondary machine, including network 
issues such as switching IP addresses.
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Pre-Installation Modifications

You must install a single instance of Registration Manager on a shared disk system.

CAUTION: There are a few files used by the Registration Manager Web Server that 
should not reside on a shared file system, but rather on a local disk. These files are 
specified via directives in /WebServer/conf/httpd.conf. The directives in question 
are: LockFile, SSLMutex, and SSLSessionCache. In order to ensure successful 
installation of Registration Manager on a shared file system, RSA recommends that 
you make modifications before running the INSTALL script. For more information, 
see “Installing RSA Registration Manager on Solaris or Linux” on page 22.

Make modifications as follows to both iws/dist/base.conf and 
WebServer/dist/base.conf, so that proper httpd.conf files are generated during the 
installation. Assuming there is a directory called /localdisk that is mounted on a local 
disk, make the following changes to both base.conf files:

#LockFile logs/accept.lock
LockFile /localdisk/accept.lock
#SSLMutex file:logs/ssl_mutex
SSLMutex file:/localdisk/ssl_mutex
#SSLSessionCache dbm:logs/ssl_scache
SSLSessionCache dbm:/localdisk/ssl_scache

Note: For testing, you can use /tmp as the local disk mounted directory. However, for 
security reasons, RSA recommends not using /tmp for production systems. For more 
information, go to 
http://httpd.apache.org/docs/2.0/mod/mpm_common.html#lockfile.

Apache uses the file named in the SSLSessionCache directive as is without appending 
a process ID (as it does for the other two directives). In the unlikely event that two 
separate installations of Registration Manager are configured to point to the same 
directory on the same machine (for example, /localdisk), this could cause a conflict. 
The two separate Registration Manager installations should use separate directories 
for their SSLSessionCache, that is, /localdisk/install1 for one and /localdisk/install2 
for the other.

Startup Procedure

On the secondary machine:

1. Start Registration Manager using the START script.
This allows you to enter any required PINs or passphrases.

2. When all servers have started, run the DISABLE script.
Running the DISABLE script puts Registration Manager into standby mode, 
allowing it to be restarted without prompting the Administrator for the ENABLE 
script.

3. Confirm that Registration Manager is disabled by checking the system log.
For example:

Sep 18 09:41:42 sparc-11 xudad[24624]: [ID 373491 
local0.info] (INFORMATION) Switched to standby mode at: 
Wed Sep 18 09:41:34 2007
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On the primary machine:

• Start Registration Manager using the START script.
For more information, see “Starting RSA Registration Manager on Solaris or 
Linux” on page 36.

Failover to the Secondary Machine

Important: It is assumed that the primary Registration Manager has failed and its 
server processes are no longer running. In the case of a partial failure (that is, some 
server processes are still running and you can access the primary machine), stop those 
server processes by running the STOP script on the primary machine.

On the secondary machine:

1. Run REMOVEPID to remove each of the server .pid files, that is, xslogsrv.pid, 
httpd.pid, and xudad.pid.
If any of these files exist, the ENABLE script fails. This is a precaution against 
accidentally enabling the Registration Manager when there is another fully 
operational instance of Registration Manager.

2. Run the ENABLE script.
Running the ENABLE script brings the standby Registration Manager into 
operation without prompting the Administrator, enabling an automated process to 
trigger startup.
It takes a few moments for the secondary to become fully operational. The system 
log indicates when Registration Manager is fully operational, but there is no 
automated way (through a script) to determine this.

Restarting the Primary Machine

To restart the primary machine:

1. On the secondary machine, run the STOP script.

2. Repeat the startup procedure.
For more information, see “Startup Procedure” on page 37.
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3 Upgrading RSA Registration Manager

This chapter describes how to upgrade RSA Registration Manager. It includes 
information about troubleshooting the upgrade.

Upgrading RSA Registration Manager

RSA Registration Manager 6.9 supports upgrades from RSA Keon Registration 
Authority/Registration Manager 6.5.1 and later. If you are upgrading from a version of 
RSA Sentry Registration Authority or a version of RSA Keon Registration Authority 
earlier than 6.5.1, contact RSA Customer Support for information on how to 
successfully upgrade.

You can also use the upgrader to move an existing RSA Registration Manager 6.9 
installation to another machine or platform.

Upgrading leaves your previous installation of Registration Manager intact. You can 
continue to use the previous installation as a reference if necessary and uninstall it 
when you are ready. However, you must not continue to issue and manage certificates 
with the previous installation. 

Important: X-Parse templates, configuration files, and web ACL rules are not 
migrated from the previous version to RSA Registration Manager 6.9. Any manual 
changes that you have made must be manually migrated to the new installation.

Preparing to Upgrade

Take the following steps before beginning a Registration Manager upgrade:

1. Ensure that the target CA installation has been upgraded to RSA Certificate 
Manager 6.9.

2. Back up your entire existing installation. The upgrade process should not modify 
your existing installation; however, a complete backup is a wise precaution.

3. Verify that you have sufficient disk space available. You need an additional 
amount of space roughly equal to the space used by your existing installation.

4. Record the port numbers for the various virtual web servers, found in the 
httpd.conf file. You are prompted to verify these port numbers during the 
upgrade. The four virtual web servers are the Administration Server, Enrollment 
Server, SCEP Server, and Certificate Renewal Server.

5. Install the RSA BSAFE SSL-C 2.8.5.1 library files on the host where the 
upgraded Registration Manager will be installed. See “Installing RSA BSAFE 
SSL-C Library Files” on page 18.

6. Enable SSL 3.0 and TLS 1.0 in your browser. See “Enabling SSL 3.0 and TLS 
1.0” on page 19.
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7. If you are upgrading from an RSA Registration Manager 6.8 build 520 installation 
that uses nCipher PKCS #11 SSL keys, configure the nCipher PKCS #11 provider 
on the host where the upgraded Registration Manager will be installed. See 
“Configuring the nCipher PKCS #11 Provider” on page 19.

8. If your existing SSL keys are nCipher native keys, regenerate the SSL keys as 
software-based keys. Whether you reissue the certificates or regenerate the SSL 
keys and Log Signing key, select RSA as the cryptographic provider. For 
instructions, see “Reissuing RSA Registration Manager SSL Certificates” in the 
chapter “System Maintenance” in the Administrator’s Guide.

9. If you are upgrading an installation on Solaris SPARC, ensure that your existing 
installation directory does not contain symbolic links to non-existent files.
If run from the top level of the installation directory, the following command 
identifies all such files:

find . -type l -exec test \! -e {} \; -print

Creating the Upgrade Package

You begin the upgrade process on the machine where the installation you are 
upgrading is located. The first step in upgrading Registration Manager is the creation 
of an upgrade package. The upgrade package is an image of your existing installation, 
which can be used to migrate to other machines or platforms. The setup procedure for 
RSA Registration Manager 6.9 uses this package as input to the setup process so that 
the newly installed product carries all of your previous certificates, LDAP ACL rules, 
and so on.

After the upgrade package is created, you can continue with the upgrade and 
installation of RSA Registration Manager 6.9, or complete the package creation and 
exit. If you exit the upgrade process, the information gathered by the upgrader is 
packaged in a file called package.tar. This file can be moved to another machine to 
complete the upgrade and installation of RSA Registration Manager 6.9.

Note: The database backup configuration object is not copied from the original 
installation’s xudad.conf file when an upgrade is performed. The upgraded 
installation is installed with default settings. This allows any automatic backups on the 
original installation to continue and to not interfere with the upgraded installation. You 
must manually upgrade the new installation’s database backup configuration from the 
original installation.

Creating the Upgrade Package on Windows

The Windows version of RSA Registration Manager 6.9 consists of both a zipped and 
an uncompressed distribution of setup files.

Prerequisite

Ensure that you have Windows Administrator privileges.
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To begin the upgrade process:

1. Stop all the services of the existing installation.

2. Unzip RSARM-v6.9build551r-WIN32.zip to a temporary directory.

3. Run setup.exe, either directly from the \uncompressed directory or from a 
temporary directory to which you have unzipped the zipped files. (Your version 
of unzip or WinZip must support long filenames.)

4. Do one of the following:

• To use your computer’s default browser for installation and administration, 
select Use Default Browser and click Next.

• To use another browser:

a. Select Use Other Browser and click Next.

b. Select the browser you want to use.

5. Select Upgrade and click Next.

6. Select Create an Upgrade Package and click Next.

7. Specify the directory where the existing installation is located and click Next.

8. Specify the directory in which to create the upgrade package and click Next.
The default location is the \installed-dir\Upgrader directory.
The upgrade package is created. This process may take a few moments.

9. Do one of the following:

• To upgrade Registration Manager to a different machine or platform, click 
Finish Package Creation and Exit.
The upgrade package is collected into a file called package.tar. The upgrader 
looks for this file; do not change the filename.
If you are upgrading Registration Manager to another Windows machine, 
complete the installation according to the instructions in “Completing an 
Upgrade on Windows” on page 43.
If you are upgrading your operating system from Windows 2000 Server to 
Windows Server 2003 or 2008 or from Windows Server 2003 to Windows 
Server 2008, upgrade the operating system now, and then complete the 
installation according to the instructions in “Completing an Upgrade on 
Windows” on page 43.
If you are upgrading Registration Manager from a Windows machine to a 
Solaris or Linux machine, copy the package.tar file to the Solaris or Linux 
machine and complete the installation according to the instructions in 
“Completing an Upgrade on Solaris or Linux” on page 46.

• To continue the upgrade installation on the current machine, click Continue 
Upgrade Using This Package and click Next.
Complete the installation according to the instructions in “Completing an 
Upgrade on Windows” on page 43, beginning with step 7.
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Creating the Upgrade Package on Solaris or Linux

The Solaris and Linux distribution packages contain two tar files: the main 
distribution tar file and an upgrade distribution tar file. You need both files to 
complete the upgrade.

To begin the upgrade process:

1. If you are completing the upgrade on the same Solaris or Linux machine, copy the 
main distribution tar file, RSARM-v6.9build551r-sparc-sun-solaris.tar, 
RSARM-v6.9build551r-linux.tar, or RSARM-v6.9build551r-SuSE_linux.tar 
depending on your platform, to the directory where you want to install the new 
installation, for example, /usr/local/newRM/. 

2. Untar the distribution.
The file is untarred to a new /RSA_RM directory within the current directory.

3. Stop all services of your existing installation.

4. Copy the upgrade distribution tar file, 
RSARM-v6.9build551r-sparc-sun-solaris.upgrade.tar, 
RSARM-v6.9build551r-linux.upgrade.tar, or 
RSARM-v6.9build551r-SuSE_linux.upgrade.tar depending on your platform, 
to the installation directory of the existing installation, for example, 
/usr/local/RM/.

5. Delete the /Upgrader directory and its contents from the existing installation.

6. Untar the upgrade distribution tar file.
A new /Upgrader directory is created under the installation directory of the 
existing installation.

7. Change directories to the new /Upgrader directory and run the UPGRADE script.

8. When prompted to select the directory in which to create the upgrade package, do 
one of the following:

• To accept the default location, press ENTER.

• Enter the directory and press ENTER.
The UPGRADE script creates a new upgrade package.

Note: You can use the UPGRADE script to move the installation to another 
location without actually doing an upgrade to a new version. For this scenario, use 
the default upgrader provided with the initial installation.

9. When prompted to indicate whether you want to complete the upgrade installation 
now or at another time, do one of the following:

• To install RSA Registration Manager 6.9 to the same machine now, press 1 
and Enter.
When prompted, enter the location of the new installation from step 1 and 
press Enter.
Complete the installation according to the instructions in “Completing an 
Upgrade on Solaris or Linux” on page 46, beginning with step 5.
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• To install the upgrade to a different machine or platform, press 2 and Enter.
The upgrade package is collected into a file called package.tar.
If you are upgrading Registration Manager to another Solaris or Linux 
machine, complete the installation according to the instructions in 
“Completing an Upgrade on Solaris or Linux” on page 46.
If you are upgrading an Registration Manager installation from a Solaris or 
Linux machine to a Windows machine, copy the package.tar file to the 
Windows machine and complete the installation according to the instructions 
in “Completing an Upgrade on Windows” on page 43.

Completing an Upgrade

After you have created the upgrade package, follow the instructions in this section to 
complete the Registration Manager upgrade.

Prerequisites

• The target CA installation must be upgraded to RSA Certificate Manager 6.9 
before you can complete the Registration Manager upgrade.

• If you are completing the upgrade on a different machine or platform than the 
original installation, copy the file package.tar to the machine where you intend to 
install RSA Registration Manager 6.9.

• If you are completing the upgrade on a Windows platform, ensure that you have 
Windows Administrator privileges.

Completing an Upgrade on Windows

If you are completing the RSA Registration Manager 6.9 upgrade on the same 
machine as your existing installation and you selected Continue Upgrade Using This 
Package and clicked Next in step 9 of “Creating the Upgrade Package on Windows” 
on page 40, go to step 7 to continue the upgrade.

To complete the upgrade process:

1. If you are upgrading to the same machine and want to use the same port numbers, 
stop all services of the existing installation.

2. Run setup.exe, either directly from the \uncompressed directory or from a 
temporary directory to which you have unzipped the zipped files. (Your version of 
unzip or WinZip must support long filenames.)

3. Do one of the following:

• To use your computer’s default browser for installation and administration, 
select Use Default Browser and click Next.

• To use another browser:

a. Select Use Other Browser and click Next.

b. Select the browser you want to use.

4. Select Upgrade and click Next.
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5. Select Use Previously Prepared Upgrade Package and click Next.

6. Specify the location of the folder containing the package.tar file and click Next.
If you do not know the full path to the package.tar file, click Browse and locate 
the package.tar file.

Note: Clicking Browse opens a dialog box containing the instructions “Please 
choose the installation folder.” This default InstallShield message may be 
misleading. You only need to specify the path to the package.tar file at this point.

7. Select the folder where you want to install RSA Registration Manager 6.9 and 
click Next.
The folder is checked to ensure that it is empty, and then the upgrade package is 
copied to the folder.
The Original Server Ports dialog box opens.

8. Verify the original port numbers from the existing installation and click OK.
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9. If the Administration Server and Enrollment Server keys were encrypted in the 
existing installation, when prompted, enter the passphrase that was used and click 
OK.
The Upgrader Port Info dialog box opens.

10. If needed, edit the port information for the new Registration Manager installation. 
Click OK.
The upgrade process restarts the Secure Directory Server and the Administration 
Server.

11. If the SSL keys of these servers are protected by a passphrase or HSM, when 
prompted, enter the passphrase or PIN, and click OK.

Important: You may see the message described in step 12 before you have been 
prompted for the passphrases of both servers. Wait until you have responded to 
both prompts before connecting to the URL provided.

12. Using your browser, connect to the URL provided: 
https://host.subdomain.com:administration-port/ra/upgrade.xuda.
The LDAP ACL Rules Modification page opens.

Note: If you are unable to access the URL, you may be using a different browser 
for the upgrade than the one used for the previous installation. If this is the case, 
export the RM Administrative certificate from the browser at the previous 
installation and import the certificate into the browser at the new installation.
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13. Click Continue to update the LDAP ACL rules.
The RSA Registration Manager 6.9 upgrade is complete. You can connect to the 
Administration Server by clicking the hyperlink on the Upgrade Complete page.

RSA Registration Manager 6.9 is now fully operational. If you upgraded to the same 
machine, both installations of Registration Manager are displayed in the Services 
dialog box in the Windows Control Panel. You can operate the previous installation 
until you have completed any customizations necessary to begin using 
RSA Registration Manager 6.9. However, any database changes you make using the 
previous version will not appear in the new version.

Completing an Upgrade on Solaris or Linux

If you are completing the upgrade on the same machine as your existing installation 
and you pressed 1 and Enter to continue the upgrade in step 9 of “Creating the 
Upgrade Package on Solaris or Linux” on page 42, go to step 5 to continue the 
upgrade.

To complete the upgrade process:

1. Copy the main distribution tar file, 
RSARM-v6.9build551r-sparc-sun-solaris.tar, 
RSARM-v6.9build551r-linux.tar, or RSARM-v6.9build551r-SuSE_linux.tar 
depending on your platform, to the directory where you want to install the new 
installation, for example, /usr/local/newRM/.

2. Untar the distribution.
The file is untarred to a new /RSA_RM directory within the current directory.

3. Change directories to the new /RSA_RM directory and run the INSTALL script.

4. When prompted to indicate whether this is a new install or an upgrade, press 2 and 
Enter.

5. Enter the path to the package.tar file and press Enter.
If you changed the default name of the package.tar file (created in step 9 of 
“Creating the Upgrade Package on Solaris or Linux” on page 42), enter the full 
path to the upgrade package, including the filename of the tar file.
If you used the default name of the package.tar file (created in step 9 of “Creating 
the Upgrade Package on Solaris or Linux” on page 42), enter the path to the 
directory containing the package.tar file.

6. Verify the original port numbers from the previous installation.
Press Enter to accept the default port numbers. To change a port number value, 
enter the correct port number and press Enter. 

7. To confirm the port numbers, press y and Enter.

8. If the Administration and Enrollment Server keys were encrypted in the previous 
installation, enter the passphrase.

9. Enter the configuration information for the new Registration Manager installation.
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10. To confirm the configuration information for the new Registration Manager 
installation, press y and Enter.
The upgrade process restarts the Secure Directory Server and the Administration 
Server.

11. If the private keys of these servers are protected by a passphrase or HSM, when 
prompted, enter the passphrase or PIN, and press Enter. 

Important: You may see the message described in step 12 before you have been 
prompted for the passphrases of both servers. Wait until you have responded to 
both prompts before connecting to the URL provided.

12. Using your browser, connect to the URL provided: 
https://host.subdomain.com:administration-port/ra/upgrade.xuda.
The LDAP ACL Rules Modification page opens.

Note: If you are unable to access the URL, you may be using a different browser 
for the upgrade than the one used for the previous installation. If this is the case, 
export the RM Administrative certificate from the browser at the previous 
installation and import the certificate into the browser at the new installation.

13. Click Continue to update the LDAP ACL rules.
The RSA Registration Manager 6.9 upgrade is complete. You can connect to the 
Administration Server by clicking the hyperlink on the Upgrade Complete page.

RSA Registration Manager 6.9 is now fully operational. If you customized files in 
your previous installation, you must manually add the file customizations to your new 
installation.

Troubleshooting an Upgrade

The upgrade process generates several log files that may be useful if an error occurs 
during the upgrade. The upgrader launches external programs for each step in the 
process. The information below summarizes the steps that can occur during the 
upgrade process and lists the log files that are relevant for each step.

In most cases, log files have the name of the executable whose output they are 
capturing. Log files with an .out extension capture the standard output stream of a 
process and files with an .err extension capture the standard error stream.

Overall

/installed-dir/Upgrader/bin/upgrader.log

This file captures the output that is displayed on the screen as the upgrader is 
executing. You can use it to determine which step was being performed when an error 
occurred.
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Database Dump and Translation

/installed-dir/Upgrader/bin/ldbmcat.tdbm.out

An LDIF representation of the original database. This file may be extremely large.

/installed-dir/Upgrader/bin/ldbmcat.tdbm.err

Any errors encountered attempting to dump the database to the LDIF file.

/installed-dir/Upgrader/bin/xu_ldbmcat.out
/installed-dir/Upgrader/bin/xu_ldbmcat.err

Output and errors from the process that performs minor adjustments to the database to 
prepare it for use with RSA Registration Manager 6.9.

/installed-dir/Upgrader/bin/deletefile.out

A list of all the objects that were automatically deleted from the database in 
preparation for RSA Registration Manager 6.9. In most cases, the objects listed here 
are re-created when the new version is installed.

Secure Directory Server Installation

/installed-dir/Xudad/bin/iXudad.log

A transcript of the Secure Directory Server installation process.

/installed-dir/Xudad/bin/xudad.out
/installed-dir/Xudad/bin/xudad.err

Output and errors resulting from Secure Directory Server installation. This file 
contains the results of attempting to set up the server on any platform. On Windows 
only, it may also contain the results of attempting to register the server as a Windows 
service and to register the uninstall program for the server.

Directory Database Indexing

/installed-dir/Xudad/bin/ldif2ldbm.out
/installed-dir/Xudad/bin/ldif2ldbm.err

Output and errors resulting from the final re-indexing of the database.

Web Server Installation

/installed-dir/WebServer/bin/iHttpd.log

A transcript of the Web Server installation process.

/installed-dir/WebServer/bin/httpsd.out
/installed-dir/WebServer/bin/httpsd.err

Output and errors resulting from the Web Server installation process. These files 
contain the results of attempting to set up the server on Solaris or Linux.
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/installed-dir/WebServer/bin/strong.out
/installed-dir/WebServer/bin/strong.err

Output and errors resulting from the Web Server installation process. These files 
contain the results of attempting to set up the server on Windows. These files may also 
contain the results of attempting to register the server as a Windows service and to 
register the uninstall program for the server.
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4 Post-Installation 

This chapter describes how RSA Registration Manager is configured during the 
installation process, including:

• The three servers that are configured

• The four virtual web servers that are configured

• The certificates that are issued

• The file directory structure

Server Configuration

When you install Registration Manager, the installation process installs three servers: 
the Web Server, the Secure Directory Server, and the Logging Server. On Windows, 
the process names are apache.exe, xudad.exe, and xslogsrv.exe respectively. On 
Solaris and Linux, the process names are httpsd, xudad, and xslogsrv respectively.
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The Web Server component is split into four virtual web servers:

Administration Server. The server through which you perform all administrative 
functions. It requires client authentication, and communication is tightly secured 
between the web server and the web client. Web ACLs are used to further control 
access.

Enrollment Server. Offers a server-authenticated site that your public users 
(clients) can use to make certificate requests and retrieve issued certificates. 

SCEP Server. Used for Simple Certificate Enrollment Protocol (SCEP) 
certificate requests. The SCEP Server does not require client authentication.

Certificate Renewal Server. Used to re-sign expired end-entity certificates.

The Secure Directory Server stores certificate requests and issued certificates in an 
LDAP database. The Secure Directory Server is also used as a read-only repository for 
public users to pick up certificates. Registration Manager also relies on the 
RSA Certificate Manager Secure Directory Server. Certificate status is checked from 
the Certificate Manager database. Like the Web Server, the Secure Directory Server 
uses client authentication to allow administration. It also uses the LDAP ACLs to 
determine what access should be granted to authenticated end-entities.

The web servers communicate securely with both the Registration Manager Secure 
Directory Server and the Certificate Manager Secure Directory Server. The 
Administration Server has almost full access to the Registration Manager Secure 
Directory and partial access to the target CA in the Certificate Manager Secure 
Directory. The Enrollment Server and SCEP Server have limited access to the 
Registration Manager Secure Directory Server. 

The Logging Server accepts securely logged PKI and system events. Log data is 
stored in local files. The log files are signed by the Logging Server. You can export the 
log files in XML and comma-separated value format to evaluate the logs for auditing 
purposes.

Issued Certificates

When you install Registration Manager, twelve certificates are issued by Certificate 
Manager to be used by Registration Manager. These certificates are stored in both the 
Certificate Manager and Registration Manager Secure Directory Servers.

RM Administrative 
Certificate

This certificate allows the person who installed Registration 
Manager to connect to the administration interface and use all 
Registration Manager functions. It is signed by the CA of the target 
Jurisdiction.

This certificate is stored in the Administrator’s browser.

Administration Server 
HTTPS Certificate

This certificate is used by the Administration Server for server 
authentication to clients who attempt to connect to it securely 
through a web browser. It is signed by the CA of the target 
Jurisdiction.

This certificate is stored as adminServer.cert in 
/installed-dir/WebServer/ssl/certs/.
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Administration Server 
SSL-LDAP Certificate

This certificate is used by the Administration Server to 
communicate with the Registration Manager and Certificate 
Manager Secure Directory Servers. It is signed by the System CA at 
the target installation. 

This certificate is stored as admin.cert in 
/installed-dir/WebServer/ssl/certs/.

Enrollment Server 
HTTPS Certificate

This certificate is used by the Enrollment Server for server 
authentication to clients who attempt to connect to it securely 
through a web browser. It is signed by the CA of the target 
Jurisdiction.

This certificate is stored as enrollServer.cert in 
/installed-dir/WebServer/ssl/certs/.

Enrollment Server 
SSL-LDAP Certificate

This certificate is used by the Enrollment Server to communicate 
with the Registration Manager Secure Directory Server. It is signed 
by the System CA at the target installation.

This certificate is stored as enroll.cert in 
/installed-dir/WebServer/ssl/certs/.

Logging Server SSL 
Certificate

This certificate is used by the Logging Server to establish SSL 
connections to clients sending log messages to the Logging Server. 
It is signed by the System CA at the target installation.

This certificate is stored as server_ssl.cert in 
/installed-dir/LogServer/ssl/certs/.

Log Signing 
Certificate

This certificate is used by the Logging Server to sign logs so they 
are secure. It is signed by the System CA at the target installation.

This certificate is stored as signing.cert in 
/installed-dir/LogServer/sign/certs/.

XUDAD Root Access 
Certificate

This certificate is used only during Registration Manager 
installation. It provides root access to the Registration Manager 
Secure Directory Server. The certificate is signed by the System CA 
at the target installation.

This certificate is not needed by Registration Manager after 
installation is complete. RSA strongly recommends that you revoke 
it or move it to a more secure location.

This certificate is stored as root.cert in 
/installed-dir/Xudad/ssl/certs/.

XUDAD Server 
Certificate

This certificate is used internally by the Registration Manager 
Secure Directory Server for secure communications with the 
Registration Manager Web Server. It is signed by the System CA at 
the target installation.

This certificate is stored as ssl.cert in 
/installed-dir/Xudad/ssl/certs/.
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File Directory Structure

This section identifies important directories in your Registration Manager installation. 
This section does not provide a complete listing of the directories and files that appear 
in a standard Registration Manager installation.

SCEP Signing 
Certificate

This certificate is used by the SCEP Server to sign SCEP responses. 
It is signed by the CA of the target Jurisdiction.

This certificate is stored as scepServerSigning.cert in 
/installed-dir/WebServer/ssl/certs/.

SCEP Encryption 
Certificate

This certificate is used by the SCEP Server to encrypt SCEP 
responses. It is signed by the CA of the target Jurisdiction.

This certificate is stored as scepServerEncryption.cert in 
/installed-dir/WebServer/ssl/certs/.

SCEP Server 
SSL-LDAP Certificate

This certificate is used by the SCEP Server to communicate with the 
Secure Directory Server. It is signed by the System CA at the target 
installation.

This certificate is stored as scep.cert in 
/installed-dir/WebServer/ssl/certs/.

 audit-logs

Default audit log archive directory

 conf

Unattended startup directory

 LogServer

Logging Server root directory

 conf

Logging Server configuration directory

 logs

Registration Manager log files directory

 Utils

Utilities directory
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 WebServer

Web Server root directory

 admin-server

Administration Server document root directory

 ra

 admin-ops

Administrator Operations Workbench directory

 auditor-ops

Auditor Operations Workbench directory

 cert-ops

Certificate Operations Workbench directory

 config

System Configuration Workbench directory

 help

Administrative Operations help directory

 conf

Web Server configuration directory

 enroll-server

Enrollment Server document root directory

 extensions

Registration Manager x-templates for v3 certificate extensions 
directory

 logs

Web Server error/message logs directory

 modules

Apache web server modules

 scep-server

SCEP Server document root directory
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 scripts

JavaScript directory

 ssl

Web Server SSL certificate and key directory

 x-templates

Registration Manager x-templates (macros) directory

 Xudad

Secure Directory Server root directory

 conf

Secure Directory Server configuration directory

 db

Secure Directory Server database directory
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5 Configuring RSA Registration Manager

This chapter describes the server configuration files found in RSA Registration 
Manager.

Configuration Files

Whenever you modify a configuration file, you should restart the server that it 
configures.

Global PKI Configuration Settings

The server.conf configuration file defines product global settings such as your mail 
server and the return e-mail address of the Administrator. The file is located at 
/installed-dir/WebServer/conf/server.conf.

Web Server Configuration Settings

The Web Server configuration file defines aspects of the Registration Manager Web 
Server. This file is located at /installed-dir/WebServer/conf/httpd.conf.

Many of the settings in this configuration file are self-explanatory or are explained in 
the documentation for Apache. These settings, such as the document root, are generic 
to any web server. A number of other settings represent Registration Manager 
variables. Specifically, the settings under each of the four default virtual hosts (the 
Administration Server, the Enrollment Server, the SCEP Server, and the Certificate 
Renewal Server) affect the operational capabilities of Registration Manager. You 
should not modify the SSL directives unless you are following the directions from a 
solution found in the RSA SecurCare Online knowledge database.

Secure Directory Server Configuration Settings

The Xudad configuration file defines configurable aspects of the Secure Directory 
Server. You normally have no need to edit or change this file in any way. On Solaris or 
Linux, if you are starting the Secure Directory Server manually (without using the 
supplied script), you must specify the location of this configuration file. The file is 
located at /installed-dir/Xudad/conf/xudad.conf.

Logging Configuration Settings

The Web Server and Secure Directory Server each has its own logging configuration 
file. This file specifies the host and port of the Logging Server and the end-entity 
certificate used to connect to the Logging Server via SSL. The Web Server logging 
configuration file is located at /installed-dir/WebServer/conf/xslogclient.conf. The 
Secure Directory Server logging configuration file is located at 
/installed-dir/Xudad/conf/xslogclient.conf.
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Logging Server Configuration Settings

The Logging Server configuration file specifies the port number, service names, the 
certificate used to sign log files, and several logging options, including the log period 
and the maximum number of log entries. This configuration file is in XML format. 
The file is located at /installed-dir/LogServer/conf/xslogconf.xml.

Unattended Startup Configuration Settings

You can create a startup.conf file in the /installed-dir/conf directory to configure 
unattended startup. For more information, see the Administrator’s Guide.

Web Server Configuration

If you have installed Registration Manager on a UNIX machine in a Network File 
System (NFS) mounted directory, you should modify the LockFile directive in the 
httpd.conf file to place the lockfile on a local disk.

The syntax of this directive is:

LockFile <file path>

Important: Avoid putting the lockfile in a world writable directory. Someone could 
create a denial-of-service attack by creating lockfiles in such a directory. For more 
information, see the Apache web site at 
http://httpd.apache.org/docs/2.0/mod/mpm_common.html#lockfile.

Secure Directory Server Security Configuration

The client authentication option settings in the xudad.conf file control access to the 
Secure Directory Server by the Administration and Enrollment Servers and other 
applications that may communicate with the Registration Manager Secure Directory 
Server. The default settings should be sufficient for most installations. For more 
secure installations, you may want to modify these values.

The four security values in the xudad.conf file are:

• clientauthlevel

• verifystatus

• ldbmverify

• secureroot
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clientauthlevel

clientauthlevel specifies what level of authentication the client certificate must have to 
connect to the Secure Directory Server via SSL-LDAP.

ldbmverify

ldbmverify instructs the Secure Directory Server whether or not to check certificates 
against the local database. If the certificate is invalid (or not present), the connection is 
refused. This only applies if clientauthlevel and verifystatus are also turned on (set to 
1).

Value Value Meaning

0 Client authentication is turned off. The client’s certificate is not used by SSL. This 
setting allows a user to connect via SSL-LDAP without a certificate. However, 
because the Administration and Enrollment Servers present their certificates when 
connecting via SSL-LDAP, setting this value to 0 (zero) effectively breaks the 
product because the Web Servers will not have any permissions to read/write the 
objects that they need to. Normally, ACL rules on the objects in the directory 
allow the Administration and Enrollment Servers to do the work they require. In 
this case, no certificates are presented, thus no X.509 binding is done and the 
product does not work.

1 Client authentication is optional. Clients may present a certificate but are not 
required to. This allows clients with certificates to have their certificates checked 
to make sure a trusted CA signed them, and allows the Administration and 
Enrollment Servers to do X.509 binding. It is still possible to use SSL-LDAP 
without presenting a certificate. In such a case, the client is bound as “nobody”. If 
a client does present a certificate, it must be signed by a trusted CA. 

3 Client authentication is turned on. Clients must present a certificate signed by a 
known CA. If they do not, access is denied. This is the default setting.

Value Value Meaning

0 Verification is turned off. Certificates are not verified against the local database. 

1 Verification is turned on. This is the default setting.

The status of all presented certificates is checked against the xuda_certificate 
object in the database. Only clients with certificates that can be validated can 
connect to the Secure Directory Server using SSL-LDAP. 

Setting ldbmverify to 1 disables cross-authentication. The Secure Directory Server 
will not allow remote connections to check certificate status as the client 
certificate is not stored locally (even if the certificate signer is trusted). To enable 
cross-authentication set ldbmverify to 0, clientauthlevel to 1, and verifystatus to 1.
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verifystatus

verifystatus instructs the Secure Directory Server whether or not to verify certificates. 
Verification may only be turned on if clientauthlevel and ldbmverify are also turned on 
(set to 1). 

secureroot

secureroot instructs the Secure Directory Server whether or not root binds must be 
done via SSL.

Value Value Meaning

0 Verification is turned off. Certificates are not verified on SSL connect. 

1 Verification is turned on. This is the default setting.

The client certificate is verified when the SSL connection is made.

Setting verifystatus to 1 disables cross-authentication. The Secure Directory 
Server does not allow remote connections to check certificate status as the client 
certificate is not stored locally (even if the certificate signer is trusted). To enable 
cross-authentication set verifystatus to 0.

This flag has no function unless clientauthlevel and ldbmverify are set to 1.

Value Value Meaning

0 Client root binds are allowed via a non-secure port. 

1 Client root binds must be done via SSL; you cannot connect to the non-secure port 
and pass in the root bind DN to get root access. This is the default setting.
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The following table illustrates the level of access granted to the Secure Directory 
Server in various situations, depending on the clientauthlevel, ldbmverify, and 
verifystatus settings.

Option Setting

clientauthlevel 0 0 0 0 1 1 1 1 3 3 3 3

ldbmverify 0 0 1 1 0 0 1 1 0 0 1 1

verifystatus 0 1 0 1 0 1 0 1 0 1 0 1

Certificate Presented Access Granted?

No certificate presented Y   Y Y Y Y Y Y Y N N N N

Certificate issued by local 
CA in database 

Y Y Y Y Y Y Y Y Y Y Y Y

Certificate issued by 
trusted CA 

Y Y Y Y Y Y Y N Y Y Y N

Certificate issued by 
unknown CA

Y Y Y Y N N N N N N N N

Certificate issued by local 
CA not in database   

Y Y Y Y Y Y Y N Y Y Y N

Revoked certificate Y Y Y Y Y Y Y N Y Y Y N
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A Cryptographic Hardware Interoperability

This appendix provides information on how RSA Registration Manager and 
cryptographic products work together.

Note: The RSA Interoperability Lab tests products on an ongoing basis. For additional 
interoperability information, visit the RSA Customer Support web site.

Secured by RSA Products

As part of the Secured by RSA Certified Partner Program, we work to assure 
customers that stringent interoperability criteria have been met by providing our 
technology partners with the Secured by RSA seal of approval. This designation 
applies to any product that has been tested in the RSA Interoperability Lab and has 
been proven to meet the rigorous integration requirements of large-scale PKI 
deployments. 

RSA Registration Manager is interoperable with the following specific cryptographic 
hardware products:

• nCipher nShield and netHSM

• SafeNet Luna CA3 and Luna SA

Registration Manager is interoperable with hardware devices compatible with 
versions 1 and 2 of PKCS #11.

For more information about Secured by RSA products, visit the RSA Solutions 
Gallery at www.securedbyrsa.com for the RSA Secured Implementation Guides.

Private Key Protection

With Registration Manager, all private keys can be protected in hardware. The 
following table shows which type of token or smart card is recommended for each 
type of key. The options marked * are possible, but not recommended as MofN 
sign-on would be required at startup (which negates many of the security benefits 
MofN offers).

MofN describes the security mechanism whereby some number M out of a pool of N 
(where M is less than or equal to N) users must authenticate to perform some action 
(for example, start a service).
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Note: Where MofN is used in this appendix, M is assumed to be greater than one. M 
equal to one is a valid setting, however it is discussed separately as the security 
considerations are different.

Protection Levels

Software

Private keys that are stored in software are stored on the hard drive of the 
Registration Manager installation machine, either as a file or in the Secure Directory. 
These can be protected by a passphrase that is required to read the keys. These keys 
can be backed up and restored easily.

Standard nCipher Operator Card Set

Private keys are generated by the nCipher hardware, encrypted, and then stored on a 
hard drive. The hard drive can be on the Registration Manager installation machine or, 
if using netHSM, can be on a separate machine. The private keys are never visible in 
an unencrypted form outside the nCipher Security World. (A Security World consists 
of one or more hardware modules, a set of smart cards, and some encrypted data 
stored on computer.) To access the keys, a smart card, PIN, and the original Security 
World are required. The original Security World can be re-created with a backup of the 
Security World and the Administrative Card Set (see “nCipher Security World” on 
page 69 and “Card Sets in the Security World” on page 69).

nCipher MofN

Private keys are created with an MofN-protected Operator Card Set (OCS). To access 
the key, M smart cards and PINs and the original Security World are required. The 
Security World (including the keys and smart cards) can be recovered with the 
Administrative Card Set and the nCipher hardware.

Private Key Type nCipher
MofN 
nCipher

SafeNet 

Luna CA3

MofN 
SafeNet 

Luna CA3

SafeNet 
Luna SA

Registration Manager 
Server keys

         Y          Y1          N  N Y

Registration Manager 
target CAs

         Y          Y*          Y          Y* Y

1   Only supported when M=1 for PKCS #11 keys.
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Standard Luna CA3 Token

Private keys are stored on a token protected by a PIN. To access the keys, it is 
necessary to have the token, the black key (see “Description of Datakeys” on page 78) 
and PIN, and a SafeNet token reader. PINs are difficult to crack as the token data 
becomes unreadable after ten (10) login failures. Tokens and user keys can be cloned 
for backup purposes in the event the originals are lost or destroyed.

SafeNet Luna CA3 MofN

Private keys are created on a smart card with MofN protection. To access the keys, an 
MofN logon is required (needs M green keys), the black key and PIN, and a SafeNet 
token reader. The token and the black key can be cloned for recovery. The green MofN 
keys cannot be cloned. If more than N minus M keys are lost, the keys on the tokens 
cannot be recovered.

SafeNet Luna SA

Private keys are stored on a partition protected by a PIN. To access the keys, it is 
necessary to have the partition PIN. The partition must be configured with Hardware 
Security Modules (HSMs) to provide provisioning for encryption, decryption, 
authentication, and signing services. SafeNet Luna SA PKCS #11 SSL keys are 
generated on the first available slot.

nCipher 1 of N

1 of N where N is greater than one is a special case of MofN. This configuration gives 
no greater security than a standard configuration. Instead, it allows multiple operators 
to have the ability to access the private keys.

FIPS 140-1 Level 2 or Level 3

Federal Information Processing Standards (FIPS) 140-1 Level 2 or Level 3 is provided 
by the nCipher Security Worlds that use the nShield module. SafeNet Luna CA3 
supports Level 3. For more information on FIPS requirements for cryptographic 
modules, go to www.itl.nist.gov/fipspubs/index.htm.

FIPS 140-2 Level 2 or Level 3

FIPS 140-2 Level 2 or Level 3 is provided by the nCipher Security Worlds that use the 
nCipher nShield or netHSM modules, or by the Safenet Luna SA HSM and Luna CA3 
tokens.
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Recommendations

In almost all cases, production PKIs require the added security of using hardware to 
protect private keys generated and used by the installation. This is particularly true for 
the private keys of CAs. The server and revocation list signer keys benefit to a lesser 
extent, as the cost associated with one of these keys being compromised is less than 
that of a CA private key. 

Before deciding to use MofN to protect a key, consider how the private key will be 
used. MofN was primarily designed for infrequent signing operations where all M key 
holders would be present when the signing took place. Normally, this does not apply 
to the signing of general end-entity certificates. MofN is more appropriate for use with 
root CA keys. The private key would only be needed for generating the small set of 
subordinate CAs. At all other times, the token or smart card can be locked away for 
proof against tampering. If MofN is used for keys that have to perform regular signing 
operations, either the overhead associated with using MofN becomes too heavy or the 
security it provides is compromised. If MofN login is standard when 
RSA Certificate Manager is started, the security gains it provides are minimal. If 
unattended startup is required, it is impossible to establish an MofN session where M 
is greater than one.

High Security Example

The following Registration Manager setup would provide a high security installation 
while maximizing the utility factor:

• FIPS 140-1 Level 2 HSM (nCipher nShield, nCipher netHSM, or SafeNet 
Luna SA)

• SSL keys created at installation protected by standard smart cards

• At startup, establish a session with the SSL keys
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nCipher nShield and netHSM

Introduction

nCipher nShield and netHSM are devices that generate and protect private keys, and 
provide high performance and secure hardware key management for the RSA Digital 
Certificate Solution. Using nShield and netHSM, Registration Manager deployments 
can be optimized for highly scaled e-commerce applications. nShield and netHSM are 
based on nCipher’s powerful encryption acceleration technology and provide a high 
level of performance for Registration Manager key generation, signing, verification, 
and authentication operations.

When using nCipher hardware (nShield and netHSM), keys are never revealed to the 
outside world or even to the main memory of the Registration Manager installation in 
an unencrypted format, vastly increasing the security of key data. 

Registration Manager uses nCipher hardware to generate keys using true 
hardware-based random number generation, encrypt keys for secure storage, and 
maintain key security in highly sensitive applications where federal standards level 
security is critical. Depending on how they are used, nCipher hardware devices are 
FIPS 140-1 or 140-2 Level 3 compliant.

Registration Manager supports nCipher cryptographic operations both from within 
Registration Manager software and the RSA Certificate Manager API. 
RSA Registration Manager 6.9 supports the nCipher nShield and netHSM hardware 
modules with version 11.30 and earlier software packages.

Functionality

Note: Users must ensure that the required nCipher smart card is inserted into the 
nCipher card reader before any Registration Manager operations if the card set is 
non-persistent. The smart card can be removed from the card reader if the card set is 
persistent.

Key Pair Generation 

Registration Manager and RSA Certificate Manager API can create keys using 
nCipher smart cards. These smart cards support key generation for key pairs based on 
both RSA algorithms and DSA algorithms.

RSA: 1024 bits, 2048 bits, 4096 bits 

Note: The smart card is required for key pair generation whether or not it was set to 
persistent during initialization.

Manufacturer: Thales ISS

Web site: www.thales-esecurity.com
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Key Storage

Registration Manager and Certificate Manager API support the storage of 
cryptographic keys using nCipher smart cards.

Signature Verification

Registration Manager and Certificate Manager API support signature verification 
using nCipher smart cards. 

Signing with Keys

Registration Manager and Certificate Manager API support the usage of keys stored 
in the nCipher key storage for signing operations. 

Configuration

To use the KeySafe application, you must install Java before you install the nCipher 
hardware and software. For the required version of Java, see the appropriate nCipher 
administrator guide.

• On Windows, install the nCipher software before you install the nCipher 
hardware. Windows uses plug and play, so the nCipher driver must already be 
installed to detect the hardware.

• On Solaris or Linux, install the nCipher hardware before you install the nCipher 
software.

Installing nCipher Hardware

Full installation instructions are available in the nCipher Hardware Installation Guide 
found on the nCipher installation CD. Instructions for upgrading the module firmware 
are available in the nCipher nShield/payShield Administrator Guide or 
netHSM/payShield net Administrator Guide.

Installing the nCipher Server Software

Installation instructions are available in the appropriate nCipher user guide on the 
nCipher installation CD. If you use netHSM, ensure that you set up the remote file 
server.

Note: On some older versions of the nCipher hardware, the server software cannot be 
upgraded to 6.14 or later because they are no longer supported by nCipher.

If the module type code is ‘2’ or ‘4’ (obtained by running the enquiry command), the 
nCipher software cannot be upgraded beyond v5.x.
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nCipher Security World

Before you can use the nCipher HSM, you must create a Security World. A Security 
World consists of one or more hardware modules, a set of smart cards, and some 
encrypted data stored on a computer.

To create a Security World using nShield or netHSM, you must set the hardware 
module in pre-initialization mode, create a Security World using the KeySafe 
application or the new-world command, and finally set the hardware module in 
operational state. If you use netHSM, you have the option to configure the security 
world from the front panel of the module. Detailed information on the Security World 
can be found in the appropriate nCipher administrator guide. 

Important: For use with Registration Manager, you can select 3DES or AES keys 
when you set up the security world.

Card Sets in the Security World

A Security World is designed to ensure all keys remain secure throughout their life 
cycle. Within a given security world, there are two different types of card sets; an 
Administrator Card Set and some Operator Card Sets. The Administrator Card Set is 
used to control access to recovery functions, and is created during Security World 
initialization. There is only one per Security World.

Operator Card Sets control access to application keys. Each user can access the keys 
protected by the Security World and protected by their Operator Card Set only. When 
you initialize a smart card, you must provide new Operator Card Set passphrases.

Registration Manager uses Operator Card Sets for key generation operations.

Important: Erase the smart cards used as Operator Cards before reinitializing the 
nCipher module. Otherwise, these cards must be discarded because they cannot be 
used, erased, or reformatted without the original Security World key.

nCipher Smart Card Labels

Smart card labels are defined when the smart card is initialized. They are simply a 
name that you attach to the smart card to help you organize your smart cards and keep 
track of what each one is used for. Labels can only be changed by reinitializing the 
smart card. 
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Initializing nCipher Smart Cards

Initialize nCipher smart cards before you use them with Registration Manager. Use 
one of the following methods to initialize a new smart card: 

Note: If you want to enable MofN encryption, you must create the MofN card set 
using the KeySafe or createocs utility. If you use netHSM, you can alternatively use 
the module front panel to create the card set.

• Use the nCipher KeySafe utility
Initialize nCipher smart cards using the nCipher KeySafe utility. For instructions, 
see “Creating an Operator Card Set with Keysafe” in the nCipher 
nShield/payShield or netHSM/payShield net Operator Guide.

• Use createocs
For instructions, see “Creating Operator Card Sets” in the appropriate nCipher 
operator guide.

• Use createoc-simple

path/createoc-simple  [--fips authslot] [--force] module 
slot label persist timeout password

where:

For example:

createoc-simple 1 0 token1 no 0 1234

For instructions, see “Creating Operator Card Sets” in the appropriate nCipher 
operator guide.

Installing the nCipher PKCS #11 Library

For instructions on installing the nCipher PKCS #11 library, see “nCipher application 
interfaces” in the netHSM operator guide.

--fips authslot Must be 0 if you have created a FIPS 140-1 Level 3 security 
world

--force Allows for the overwriting of non-blank cards

module Module number of the HSM, usually 1

slot Usually 0

label Name of token

persist Should be yes or no

timeout Must be 0

password mandatory, undocumented
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Checking the Installation of the nCipher PKCS #11 Library

After you have created a security world, ensure that the nCipher PKCS #11 library has 
been successfully installed by using the ckcheckinst command-line utility. In a 
FIPS 140-2 level 3 compliant security world, you need an Operator Card from the 
security world to run this utility. If you did not install your security world in 
FIPS140-2 level 3 mode, you can run the utility by using either an Operator Card or a 
fixed token.

If any tests fail, ckcheckinst displays a message indicating the failure and quits. It does 
not run any subsequent tests.

If ckcheckinst fails:

• Ensure that the nCipher server is running.

• Run the enquiry and nfkminfo commands.

If all seems in order, reinstall the nCipher library.

Configuring the nCipher PKCS #11 Provider Environment Variable

To configure the nCipher PKCS #11 provider on Windows:

1. Set the environmental variable NFAST_HOME to C:\nfast.

2. Ensure the nCipher PKCS #11 library is available at C:\nfast\bin\cknfast.dll.

3. To generate SSL PKCS #11 keys, in the C:\nfast\cknfastrc file, set the following 
variables:

• CKNFAST_NO_ACCELERATOR_SLOTS= 1

• CKNFAST_ASSUME_SINGLE_PROCESS=0

Note: Use the CKNFAST_ASSUME_SINGLE_PROCESS variable only for 
installation of Registration Manager. After the installation is complete, 
remove this flag from the cknfastrc file because the flag may slow down the 
performance of Registration Manager.

• CKNFAST_OVERRIDE_SECURITY_ASSURANCES= import

4. Restart the nCipher services.

5. Verify nCipher PKCS #11 key generation by using the ckcheckinst.exe utility in 
the C:\nfast\bin directory.

Note: Slot 0 is a virtual slot. Slot 1 is a configured token slot and is used by 
Certificate Manager for nCipher PKCS #11 key generation. The accelerator slot, 
which is slot 0, should be removed from nCipher configuration.

6. Verify that the nCipher slot is assigned to slot 0 by using the ckinfo.exe utility.

Note: nCipher PKCS#11 SSL keys support only a 1of N persistent card set.
A: Cryptographic Hardware Interoperability 71



RSA Registration Manager 6.9 Installation Guide
To configure the nCipher PKCS #11 provider on Solaris or Linux:

1. Set the environmental variable NFAST_HOME to /opt/nfast.

2. Ensure the nCipher PKCS #11 library is located at 
/opt/nfast/toolkits/PKCS11/libcknfast.so.

3. To generate SSL PKCS #11 keys, in the /opt/nfast/bin/cknfastrc file, set the 
following variables:

• CKNFAST_NO_ACCELERATOR_SLOTS= 1

• CKNFAST_ASSUME_SINGLE_PROCESS=0

Note: Use the CKNFAST_ASSUME_SINGLE_PROCESS variable only for 
installation of Registration Manager. After the installation is complete, 
remove this flag from the cknfastrc file because the flag may slow down the 
performance of Registration Manager.

• CKNFAST_OVERRIDE_SECURITY_ASSURANCES= import

4. Restart the nCipher services.

5. Verify nCipher PKCS #11 key generation by using the ckcheckinst utility in the 
/opt/nfast/bin/ckcheckinst directory.

Note: Slot 0 is a virtual slot. Slot 1 is a configured token slot and is used by 
Certificate Manager for nCipher PKCS #11 key generation. The accelerator slot, 
which is slot 0, should be removed from nCipher configuration.

6. Verify that the nCipher slot is assigned to slot 0 by using the ckinfo utility in the 
/opt/nfast/bin directory.

Note: nCipher PKCS #11 SSL keys support only a 1of N persistent card set.

Setting the nCipher PKCS #11 Provider in RSA Registration Manager

To set the PKCS #11 provider:

1. Modify the existing line in the installed-dir/Xudad/conf/xudad.conf file to 
specify the location of the PKCS #11 library.
For example, on Windows:
crypto_providers “pkcs11v2,c:\nfast\bin\cknfast.dll”

or on Solaris or Linux:
crypto_providers 
“pkcs11v2,/opt/nfast/toolkits/pkcs11/libcknfast.so”
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2. Modify the existing line in each of installed-dir/LogServer/conf/islog.conf and 
installed-dir/WebServer/conf/server.conf, to specify the location of the 
PKCS #11 library.
For example, on Windows:
crypto_providers=“pkcs11v2,c:\nfast\bin\cknfast.dll”

or on Solaris or Linux:
crypto_providers=
“pkcs11v2,/opt/nfast/toolkits/pkcs11/libcknfast.so”

3. Stop and restart Registration Manager services.

RSA Registration Manager Installation

If nCipher hardware and server software are installed before Registration Manager, 
the fact that nCipher support is available is determined during installation. You must 
initialize the smart card before you begin the Registration Manager installation. See 
“Initializing nCipher Smart Cards” on page 70.

Important: Initialize the nCipher smart card with a passphrase.

For Solaris or Linux platforms, you must install Registration Manager by the “root” 
user or by a user belonging to the nfast user group to allow operation with nCipher 
hardware.

Adding nShield or netHSM Support to an Existing 
RSA Registration Manager Installation

To add smart card support to an existing Registration Manager installation that does 
not currently use smart cards, you do not need to reinstall Registration Manager.

To add nCipher smart card support to an existing installation:

1. Install the nCipher hardware and server software as described in previous 
sections. Make sure the nFast server is running.

2. Initialize a smart card and insert it into the reader.

3. Stop and restart the Registration Manager services.

nCipher Failover

The failover feature of nCipher HSMs is supported with the following constraints:

• The Operator Card Set (OCS) used by Registration Manager must be created as an 
MofN card set with N greater than or equal to the number of modules taking part 
in the failover configuration. For example, if your configuration has two HSMs, 
you must use a card set of two or more cards since you must log in to both HSMs 
at the same time.

• If cards must be inserted at the same time, all cards in the card set must have the 
same passphrase.
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• All Registration Manager server keys must be software-based. If server keys are 
not software-based, you will not be able to access the Registration Manager Web 
Servers (that is, the Registration Manager Administration Server and the 
Enrollment Server). (This is due the manner in which the server keys are loaded 
by SSL-C at startup.)

• During Registration Manager startup (when prompted to log in by entering the 
nCipher PIN), ensure that a card from the cardset is inserted in each module that is 
part of the failover configuration.

• After an nCipher HSM has failed over, you must restart Registration Manager 
services and log into the card set after the failed nCipher HSM becomes 
operational again.

For more information on the nCipher HSM failover feature, see the appropriate 
nCipher user guide.

Recovery Features

All of the following recovery options require that the recovery option must have been 
enabled when creating the Security World:

Loss of smart card. To recover from the loss of an nCipher smart card, you can 
use KeySafe or the roc or rac command to replace any lost smart card. If you use 
netHSM, you can alternatively use the netHSM front panel. For instructions, see 
“Replacing Operator Card Sets” or “Replacing the Administrator Card Set” in the 
appropriate nCipher administrator guide. For the replacement card to work with 
the existing servers that use the original smart cards:

• Name the replacement card set the same name as the original
• Clear and remove the old card set from the Security World

Note: If you initialized the token using ckinittoken from the nCipher PKCS #11 
library version 1.5 or earlier, see “Replacing Operator Card Sets” in the nCipher 
administrator guide.

Loss of hardware. You must replace the actual hardware module (nShield or 
netHSM). After replacing the nCipher hardware, you must recreate the Security 
World using the new-world command, as documented in “Adding a Module to 
the Security World” in the appropriate nCipher user guide. If the replacement 
module had been used with another Security World, then you must initialize that 
module using the initunit command before using new-world.

Use this procedure to move the Security World from one machine to another, 
including across platforms.

Loss of hard drive data. If files containing the Security World data are lost (for 
example, /kmdata/ directory), restore the files from backup. Any data created 
since the last backup will be lost. If the complete nCipher software installation is 
damaged or lost, follow the procedure referred to for loss of hardware, provided a 
backup of the Security World data exists.
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Useful nCipher Commands

• enquiry—confirms versions of server software and module firmware

• ckcheckinst—confirms the nCipher PKCS #11 library version and determines the 
label of any cards inserted in the reader

• nfkminfo—obtain information about the Security World, that is, whether 
recovery option is enabled

Using nCipher Smart Cards with RSA Certificate Manager API

When using nCipher smart cards with Certificate Manager API sample programs, you 
must define the smart card PROVIDER_NAME. The definition is as follows:

PROVIDER_NAME “XCSP nCipher Native”
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SafeNet Luna CA3 and Luna SA

Introduction

Luna CA3 and Luna SA are Public-Key Cryptographic Standard #11 (PKCS #11) 
compliant hardware-based security products that safeguard digital key management 
by protecting Registration Manager keys in a hardware device rather than in software 
on the host computer. Luna CA3 and Luna SA provide the RSA Digital Certificate 
Solution with the highest level of security for CA key management and provide 
assurance that CA keys will not be compromised by outside intruders, viruses, 
inadvertent erasure, or system-failure complications. 

Luna CA3 and Luna SA offload sensitive cryptographic processing, key generation, 
storage, signing, and verification from Registration Manager using a standardized 
interface called “Cryptoki.”  

The Luna CA3 is a FIPS 140-1 Level 3 compliant key management device. This 
certification is achieved with the use of a highly secure Pin Entry Device (PED) in 
concert with the reader and token hardware.

Manufacturer: SafeNet Inc.

Web site: www.safenet-inc.com
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Registration Manager and Certificate Manager API support Luna-based cryptographic 
operations. Registration Manager supports the use of Luna CA3 or Luna SA on 
Windows, Solaris, and Linux platforms. The following SafeNet configurations are 
recommended with RSA Registration Manager 6.9.

Functionality

Key Pair Generation 

Registration Manager and Certificate Manager API can create keys on tokens. 
Luna CA3 and Luna SA support key generation for varying key lengths in RSA and 
DSA key pairs.

RSA: 1024 bits, 2048 bits, 4096 bits 

DSA: 512 bits, 1024 bits, 2048 bits

Key Storage

Registration Manager and Certificate Manager API support the storage of 
cryptographic keys on the token.

Platform Reader
Token 
Firmware

Token
PED 
Firmware

Drivers

Microsoft Windows 
Server 2003

Microsoft Windows 
Server 2008

Sun Solaris 10

Luna Dock 3.97 Luna CA3 1.6.2 8.0

Red Hat Enterprise 
Linux 4, 5, or 5.5

SUSE Linux 
Enterprise Server 11

Luna Dock 3.4 Luna CA3 1.6.2 3.1-1

Microsoft Windows 
Server 2003

Microsoft Windows 
Server 2008

Sun Solaris 10

Red Hat Enterprise 
Linux 4, 5, or 5.5

SUSE Linux 
Enterprise Server 11

n/a 4.6.7 Luna SA n/a n/a
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Signing with Keys

Registration Manager and Certificate Manager API support the usage of keys on Luna 
tokens for signing operations. 

Configuration of Luna CA3

Luna CA3 and the Luna PED

The Luna CA3 token requires the use of the Luna PIN Entry Device (PED). The Luna 
PED passes PINs to the token via a direct data port into the Luna Dock. This 
requirement has allowed the Luna CA3 token to achieve FIPS 140-1 Level 3 
validation. Datakeys, along with a regular PIN entered on the PED, are used for 
accessing token functionality. Datakeys are inserted into the Luna PED to log onto the 
token.

Description of Datakeys

A number of datakeys are used with the PED. Each key is color coded and has a 
specific purpose.

Token Accounts

Luna tokens have two accounts: Security Officer and User. The security officer 
account is used for configuring your token and setting up the user account. It does not 
have access to view any private keys stored on the card. A security officer must be 
created when a token is initialized before a User PIN can be established. The 
Registration Manager Administrator uses the Luna user account to access the data 
stored on the token, including the public and private keys. The user account is also 
used when cloning tokens. It has full access to all data stored on the token, including 
public and private keys. 

Luna tokens use PINs to secure access to a token. Tokens have both a user PIN and a 
security officer PIN. Luna CA3 tokens are also protected by Datakeys.

By default, PINs have a minimum length of four characters and a maximum length of 
48 characters. The default is set in the Token Policy Vector (TPV) and can be viewed 
using the SafeNet Lunadiag utility, option 7.

Grey This key is only used when initializing the token. By protecting this 
key, you can prevent accidentally (or maliciously) re-initializing the 
token.

Red This key is used in cloning.

Blue This is the security officer key and should not be required for 
day-to-day operations, therefore it should be protected along with the 
red and grey keys.

Black This is the user key and is required to create new key pairs and access 
private keys on the token.

Green These keys are used for MofN operations.
78 A: Cryptographic Hardware Interoperability



RSA Registration Manager 6.9 Installation Guide
When you initialize a token, you must provide new user and security officer PINs. 
Whenever you perform any action with Registration Manager that requires the entry 
of a PIN, only the user PIN is requested.

Luna Token Labels

Token labels are a name that you attach to a token to help you organize your tokens 
and keep track of what each one is used for. Labels are defined when the token is 
initialized, and can only be changed by re-initializing the token. If you are using more 
than one token with your Registration Manager installation at the same time, each 
token must have a distinct label.

Cryptoki Model

Luna tokens implement public key cryptography according to the PKCS #11 standard. 
The cryptographic token interface follows this standard, which mandates the Cryptoki 
model. The Cryptoki model introduces a number of logical abstractions to formalize 
token operations and management. The following points are important when using 
Luna tokens with Registration Manager:

• The Cryptoki model uses the idea of a slot to generalize addressing.

• Any Cryptoki devices in a computer can be addressed via their slot number. 

• Operations on tokens take place in the context of sessions, which can be opened or 
closed. Per-token sessions are opened on a particular token via the slot number 
(one session per token). Operations on the token are logically separated into two 
types according to the privilege level of the session.

• Administrative operations must be performed by the security officer. Normal 
operations, such as those performed by Registration Manager, are performed as 
the user. Both types of operations are secured via unique PINs or passwords. A 
security officer must be created when a token is initialized, and before a User PIN 
can be established.

Installing Luna Dock

Install the SafeNet hardware and software for Windows, Solaris, or Linux using the 
Safenet Luna Token Install Guide (InstGd.pdf) on the SafeNet Luna CD.

Installing/Upgrading Luna Drivers

Install the SafeNet Luna Drivers for Windows, Solaris, or Linux using the Safenet 
Luna Token Install Guide.

Getting Token Information

Token information can be retrieved using the Enabler utility described in Chapter 2 of 
the Safenet Luna Token User Guide (TkGd.pdf) on the SafeNet Luna CD.
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Upgrading Luna Firmware

If you have new token hardware, you should have the correct version of the firmware. 
If you are unsure, you can check your firmware version using the Lunadiag utility 
provided on the SafeNet Luna CD.

1. Run Lunadiag.exe from the \Luna directory.

2. Choose option 4, Read Firmware Level.
The version number is displayed.

If you do not have the correct firmware, contact RSA Customer Support through 
SecurCare Online.

Initializing Luna Tokens for Use with RSA Certificate Manager

Before you begin installation of RSA Registration Manager, use the Enabler utility to 
initialize the Luna token. Initialization of Luna tokens using the Enabler utility can be 
found in Chapter 2 of the SafeNet Luna Token User Guide.

During initialization, Enabler asks if you want to use MofN. If you select Yes, 
Enabler prompts for the M and N values, and the PED prompts for green Datakeys to 
imprint them with secret shares.

Note: If you are using more than one token with Registration Manager, each token 
must have a different label.

If you have already installed Registration Manager and want to initialize a new token, 
for Registration Manager or for cloning, use the Enabler utility.

RSA Registration Manager Installation

During the installation of Certificate Manager, Luna token support can be added if 
available. You must install the Luna hardware, drivers, and firmware before you 
install Certificate Manager.

Adding Luna CA3 Support to an Existing RSA Registration Manager

You do not need to re-install Registration Manager to add token support to an existing 
installation that does not use tokens.

To add token support to an existing installation:

1. Install the Luna hardware, drivers, and firmware as described in the previous 
sections.

2. Initialize a token and insert it into the reader.

3. Modify the existing line in the installed-dir/Xudad/conf/xudad.conf file to 
specify the location of the Luna library.
For example, on Windows:
crypto_providers 
“pkcs11v2,C:\Program Files\luna\cryptoki.dll”

or on Solaris or Linux:
crypto_providers “pkcs11v2,/usr/lib/libcrystoki2.so”
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4. Stop and restart Registration Manager services.

Failed Login Attempts

By default, the user is allowed ten (10) successive failed login attempts and the 
security officer is allowed three (3) successive failed login attempts.

This default is also set in the Token Policy Vector (TPV) and can be viewed by using 
the Lunadiag utility, option 7.

Important: If the user surpasses the number of allowed failed login attempts, all of the 
information on the token that Registration Manager uses is lost. If the failures 
occurred when entering the user’s PIN, the security officer must log into the token and 
initialize the user PIN. If the failures occurred when entering the security officer’s 
PIN, the token must be re-initialized.

Recovery Features

With Luna CA3 tokens, all of the relevant information is stored on the token and is 
protected by the datakeys. If a failure occurs that is connected with any part of the 
HSM (for example, hard drive failure, reader failure, or Luna reader device), you must 
reinstall the software and/or hardware and continue to use the token and datakeys as 
before. 

Loss of Token

It is highly recommended that you clone all tokens and keep the clones up to date in 
the event a token is lost. This allows operations to continue. Cloning instructions can 
be found in Chapter 5 of the SafeNet Luna Token User Guide.

Note: Cloning completely overwrites any user data currently on the destination token. 
Ensure there is no desired information on the destination token.

When performing cloning, remember these three points:

• For Luna CA3 cloning, the source token and the cloned token must share the same 
cloning vector (contained on the red key). This is set up when initializing the 
destination token.

• Cloning must be performed when logged onto both tokens as the user, not the 
security officer. The security officer does not have permission to read the private 
key information on the tokens.

• The destination token must be initialized before you clone for the first time.

Designate one token as the master and make all changes to that token and then 
reclone. If two tokens that are supposed to be clones are separately changed (i.e. create 
new CA), there is no way to sync the two tokens up again.

Note: Unlike previous cloning practices, the Enabler clones the entire token. You 
cannot clone individual elements.
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Loss of Luna CA3 Datakeys

To protect against the loss of a Luna CA3 datakey, you should make multiple copies 
when initializing the token. Initialization of Luna CA3 tokens can be found in 
Chapter 2 of the SafeNet Luna Token User Guide. RSA recommends that you make a 
backup of the red (if you want to clone tokens), blue, black, and green keys and store 
them in a safe location. You cannot make additional keys after initialization is 
complete. If backups are needed after initialization, a second token would need to be 
initialized with the desired keys and then used to clone the original token.

Using Luna Tokens with RSA Certificate Manager API

When using Luna tokens with Certificate Manager API sample programs, you must 
define the token PROVIDER_NAME, PROVIDER_LIBRARY, and 
PROVIDER_TYPE. The definitions are as follows:

Configuration of Luna SA

Configure the Luna SA client, following the instructions in “Setting up Network 
Trusted Link” under “Configuration” in the Luna SA 4.3 Help. 

After you configure the Luna SA client, follow the instructions in the following 
sections to configure the Luna SA client with the Luna SA HSM. If the Luna SA HSM 
is configured with high availability, see the Luna SA documentation for instructions to 
configure the client with the Luna SA HSM server.

Import the Luna SA Server Certificate into the Client 

To import the server certificate into the client: 

1. On the client, open a command prompt, and change directories to the directory 
where Luna SA is installed. The default directory is C:\Program Files\LunaSA\. 

2. Securely transfer the server.pem file from the Luna SA, using the Chrysalis 
Transfer Program (ctp) utility. Type:

ctp admin@myLunaSA3:server.pem .

PROVIDER_NAME SafeNet 

Note: If you intend to use an older Chrysalis HSM, the 
provider name should be “Chrysalis-ITS, Inc.”

PROVIDER_LIBRARY The location of the provider’s library. 

On Windows, the default installed location for the 
library is C:\Program Files\Luna\cryst201.dll.

On Solaris and Linux, the default installed location for 
the library is /usr/lib/libcrystoki2.so.

PROVIDER_TYPE XUDA_CSP_PKCS11V2
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Note: The dot (.) at the end of the command indicates that the resulting file is 
placed in the current directory.

3. Verify that the server certificate was imported into the 
LunaSA-installation-directory\cert\server directory on the client.

Register the HSM Server Certificate with the Client 

You must register the server certificate with the client so that the client can create a 
secure connection with the HSM (the server).

To register the server certificate with the client:

1. On the client, open a command prompt, and change directories to the directory 
where Luna SA is installed.

2. Register the server certificate using the vtl utility. Type:

vtl addServer -n <LunaSAhostname-or-IPaddress> 
-c server.pem

Create a Client Certificate

To create a certificate and private key for the client:

1. On the client, open a command prompt, and change directories to the directory 
where Luna SA is installed.

2. Create a certificate using the vtl utility. Type: 

vtl createCert -n <clientHostname>

Note: The client hostname is case sensitive.

3. Verify that the certificate file, clientHostname.pem, and the key file, 
clientHostnameKey.pem, were created in the 
LunaSA-installation-directory\cert\client directory. 

After the createCert command, the vtl utility gives the full pathname to the certificate 
and key files that were generated.

Export the Client Certificate to the Luna SA 

To export the client certificate to the Luna SA:

1. On the client, open a command prompt, and change directories to the directory 
where Luna SA is installed.

2. Export the client certificate to the Luna SA HSM, using the ctp utility. Type:

ctp cert\client\clientHostname.pem 
admin@<serverhostname-or-IP>:/ 

When prompted, enter the password of the Luna SA server administrator.
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Register the Client Certificate to an HSM Partition

You must be connected to the HSM server (the Luna SA) and logged in as “admin”.

To register the client certificate with the server:

From the Luna command shell, type:

lunash:> client -register -client <client-name> -hostname 
<clientHostname> -installcert clientHostname.pem

where <client-name> is any string that allows you to easily identify this client. The 
client certificate filename is the same as the client hostname.

Assign a Client to a Server Partition

You must be connected to the HSM server (the Luna SA) and logged in as “admin”.

To assign the registered client to the HSM partition: 

From the Luna command shell, type:

lunash:> client assignPartition -client <client-name> 
-partition <partition-name>

Update the Luna SA Backup Token Firmware

If you update the appliance, you should update any Backup tokens. For instructions, 
see “Backup and Restore” under “Administration and Maintenance” in the 
Luna SA 4.3 Help.

RSA Registration Manager Installation

During the installation of Certificate Manager, Luna token support can be added if 
available. You must install the Luna hardware, drivers, and firmware before you 
install Certificate Manager.

Adding Luna SA Support to an Existing RSA Registration Manager

You do not need to re-install Registration Manager to add token support to an existing 
installation that does not use tokens.

To add token support to an existing installation:

1. Install the Luna hardware, drivers, and firmware as described in the previous 
sections.

2. Initialize a token and insert it into the reader.

3. Modify the existing line in the installed-dir/Xudad/conf/xudad.conf file to 
specify the location of the Luna library.
For example, on Windows:
crypto_providers 
“pkcs11v2,C:\Program Files\LunaSA\cryptoki.dll”

or on Solaris or Linux:
crypto_providers “pkcs11v2,/usr/lunasa/lib/libCryptoki2.so”
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4. Modify the existing line in each of installed-dir/LogServer/conf/islog.conf and 
installed-dir/WebServer/conf/server.conf, to specify the location of the Luna 
library. 
For example, on Windows:
crypto_providers=
“pkcs11v2,C:\Program Files\LunaSA\cryptoki.dll”

or on Solaris or Linux:
crypto_providers=“pkcs11v2,/usr/lunasa/lib/libCryptoki2.so”

5. Stop and restart Registration Manager services.

Using Luna Tokens with RSA Certificate Manager API

When using Luna tokens with Certificate Manager API sample programs, you must 
define the token PROVIDER_NAME, PROVIDER_LIBRARY, and 
PROVIDER_TYPE. The definitions are as follows:

Additional Information

For further details on PKCS #11 (the RSA PKCS #11 FAQ), go to 
www.rsa.com/rsalabs/node.asp?id=2133.

PROVIDER_NAME SafeNet, Inc.

PROVIDER_LIBRARY The location of the provider’s library. 

On Windows, the default installed location for the 
library is C:\Program Files\LunaSA\cryptoki.dll.

On Solaris and Linux, the default installed location for 
the library is /usr/lunasa/lib/libCryptoki2.so.

PROVIDER_TYPE XUDA_CSP_PKCS11V2
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B Uninstalling RSA Registration Manager

This appendix describes how to uninstall RSA Registration Manager.

Uninstalling on Windows Server 2003

CAUTION: Removing Registration Manager directories removes all information 
relating to your PKI. You may want to back up the directories before uninstalling 
Registration Manager.

To uninstall RSA Registration Manager:

Note: If you have more than one installation of Registration Manager on the same 
machine, a number is added to the service names of subsequent installations. For 
example, [02] is added to the end of each service name for the second installation.

1. Stop the Registration Manager services:

a. Click Start > Programs > Administrative Tools > Services.

b. From the Services list, select RSA RM 6.9 build551 (Administration) and 
click Stop.

c. From the Services list, select RSA RM 6.9 build551 (Secure Directory) and 
click Stop.
The Secure Directory Server is required for the Administration Server to 
operate. If you attempt to stop the Secure Directory Server before the 
Administration Server, both servers stop.

d. From the Services list, select RSA Secure Logging Server 6.9 and click 
Stop.

e. Close the Services dialog box.

2. Click Start > Settings > Control Panel and double-click Add or Remove 
Programs.

3. Select RSA RM 6.9 build551 (Secure Directory) and click Change/Remove.

4. Select RSA RM 6.9 build551 (Administration) and click Change/Remove.

5. Select RSA Secure Logging Server 6.9 and click Change/Remove.

Note: You can also uninstall the Installation Servers in the same manner. 

6. Click OK to close the Add or Remove Programs dialog box.

7. Delete the \installed-dir\RSA_RM directory.
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Uninstalling on Windows Server 2008

CAUTION: Removing Registration Manager directories removes all information 
relating to your PKI. You may want to back up the directories before uninstalling 
Registration Manager.

To uninstall RSA Registration Manager:

Note: If you have more than one installation of Registration Manager on the same 
machine, a number is added to the service names of subsequent installations. For 
example, [02] is added to the end of each service name for the second installation.

1. Stop the Registration Manager services:

a. Click Start > Programs > Administrative Tools > Services.

b. From the Services list, select RSA RM 6.9 build551 (Administration) and 
click Stop.

c. From the Services list, select RSA RM 6.9 build551 (Secure Directory) and 
click Stop.
The Secure Directory Server is required for the Administration Server to 
operate. If you attempt to stop the Secure Directory Server before the 
Administration Server, both servers stop.

d. From the Services list, select RSA Secure Logging Server 6.9 and click 
Stop.

e. Close the Services dialog box.

2. Click Start > Control Panel > Programs > Programs and Features.

3. Select RSA RM 6.9 build551 (Secure Directory) and click Uninstall/Remove.

4. Select RSA RM 6.9 build551 (Administration) and click Uninstall/Remove.

5. Select RSA Secure Logging Server 6.9 and click Uninstall/Remove.

Note: You can also uninstall the Installation Servers in the same manner. 

6. Close the Programs and Features dialog box.

7. Delete the \installed-dir\RSA_RM directory.
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Uninstalling on Solaris or Linux

CAUTION: Removing Registration Manager directories removes all information 
relating to your PKI. You may want to back up the directories before uninstalling 
Registration Manager.

To uninstall RSA Registration Manager:

1. Stop Registration Manager:

a. Change directories to the directory where you installed Registration Manager.

b. At the command prompt enter:

./STOP

2. Remove the installed Registration Manager file system directories.

Note: To uninstall the installation servers, delete the directories /installed-dir/ids/ and 
/installed-dir/iws/.
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C Media Verification

Media verification enables you to verify the integrity of the shipped product. You can 
verify that the distribution media has not been altered since it was signed by RSA.

Media verification is a two-step procedure. The first step is to validate the media. A 
second, optional step, if you want a higher degree of assurance, is to validate the 
verification certificate and the media verification utility.

Validating the Media

To validate the distribution media:

1. At the command prompt, change directory to the top directory of the product CD.

2. Run the media verification utility from the top directory of the product CD. 
Depending on your platform, do one of the following:

• On Windows, type:

.\Windows\Utils\mediaverify.exe .

• On Solaris, type:

./Solaris/Utils/mediaverify .

• On Red Hat Linux, type:

./RH_Linux/Utils/mediaverify .

• On SUSE Linux, type:

./SuSE_Linux/Utils/mediaverify .
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3. Check the success message at the end of the output and verify that the media 
verification utility did not report any errors.
If the verification is successful, you see output like the following example (output 
varies depending on the content of the CD).

If there are any errors, consider your distribution to be suspect. Contact 
RSA Customer Support. For a list of error messages, see the Administrator’s 
Guide.

Validating the Certificate and the Utility

Before you can validate the verification certificate and the media verification utility, 
you need to obtain the following from RSA:

• The verification certificate

• The MD5 code of the media verification utility for your platform (Windows, 
Solaris, or Linux)

To obtain the verification certificate and MD5 code:

1. Go to https://knowledge.rsasecurity.com/ and log on with your user name and 
password.

2. Under Browse by Product Family, click RSA Digital Certificates.
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3. On the Product Documentation tab, click RSA Certificate Manager 6.9 Media 
Validation Utilities.

4. Download the verification certificate and obtain the MD5 checksums for the 
verification certificate and the mediaverify utility for your platform.

If you want a higher degree of assurance, you can contact your account manager to 
obtain the verification certificate and the MD5 code.

Validating the Verification Certificate

To validate the verification certificate:

1. At the command prompt, change directory to the top directory of the product CD.

2. Run the media verification utility with the -signercert and -verifycert options. 
Depending on your platform, do one of the following:

• On Windows platforms, type:

.\Windows\Utils\mediaverify.exe -signercert certfile 
-verifycert yes .

• On Solaris, type:

./Solaris/Utils/mediaverify -signercert certfile 
-verifycert yes .

• On Red Hat Linux, type:

./RH_Linux/Utils/mediaverify -signercert certfile 
-verifycert yes .

• On SUSE Linux, type:

./SuSE_Linux/Utils/mediaverify -signercert certfile 
-verifycert yes .

where certfile is the name of the verification certificate that you obtained from 
RSA.

3. Verify that the media verification utility did not report any errors.
If the validation is successful, the media verification utility returns the message, 
“Specified certificate matches the certificate found in the media signature file.”
If the certificate specified by the -signercert option does not match the certificate 
used to sign the media, the media verification utility raises an error. If this 
happens, consider your distribution to be suspect. Contact RSA Customer 
Support.
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Validating the Media Verification Utility

You need an MD5 summing utility, such as OpenSSL (for Windows, Solaris, or Linux, 
depending on your platform) or the UNIX md5sum utility, to validate the media 
verification utility.

To validate the media verification utility: 

1. Run your MD5 summing utility on the media verification utility, mediaverify.exe 
in the \Windows\Utils directory, or mediaverify in the /Solaris/Utils, 
/RH_Linux/Utils, or /SuSE_Linux/Utils directory, depending on your platform.

2. Verify that the MD5 sum you calculate matches the one you obtained from RSA.
If they do not match, consider your distribution to be suspect. Contact 
RSA Customer Support. 
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Glossary

Abstract Syntax Notation One (ASN.1)
Abstract Syntax Notation One (ASN.1) is an International Standards Organization 
(ISO) standard notation for defining the syntax of information data. It defines a 
number of simple data types and specifies a notation for referencing these types and 
for specifying values of these types.

ActiveX Control
ActiveX control is a software component that may be downloaded and installed 
automatically through a web browser, allowing web pages to utilize capabilities of the 
Windows operating system that they would ordinarily not have access to. ActiveX 
controls are typically signed with a digital certificate, allowing users to confidently 
establish the origin of the software before deciding to trust it.

Access Control Lists (ACL)
ACLs control who can access different parts of a system. In the RSA Digital 
Certificate Solution product suite, ACLs are used primarily to control who has access 
to files and directories on a web server.

Administration Server
A virtual web server that is a component of the RSA Certificate Manager and 
RSA Registration Manager Web Servers. The Administration Server is used by 
Administrators to manage Certificate Manager or Registration Manager via a web 
interface. The Administration Server requires client authentication. It also 
communicates securely with the Secure Directory Server.

Administrative CA
A CA created during RSA Certificate Manager installation. This CA signs the 
end-entity certificates for all RSA Certificate Manager Administrators, Vettors, and 
Auditors.

Administrative Certificate
An end-entity certificate issued to one of three Administrative types: Administrator, 
Vettor, and Auditor. RSA Certificate Manager Administrative certificates are signed 
by the Administrative CA; RSA Registration Manager Administrative certificates are 
signed by the CA of the Registration Manager initial target Jurisdiction.

Administrator
A person, possibly with an end-entity certificate, who has access to certain 
administration features through the Administration Server, which may include the CA 
Operations, Administrator Operations, and System Configuration Workbenches. 
Administrator tasks may include planning the PKI implementation, installing 
components of the RSA Digital Certificate Solution product suite, performing initial 
configuration, and managing the daily administration tasks.
The RSA Certificate Manager Administrator certificate is signed by the 
Administrative CA; the RSA Registration Manager Administrator certificate is signed 
by the CA of the Registration Manager initial target Jurisdiction.

Anonymity
The ability of participating entities to use public keys while revealing only that 
information that is pertinent to the situation.
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ARL
See Authority Revocation Lists.

ASN.1
See Abstract Syntax Notation One.

Attribute Certificate
A certificate that emphasizes the holder’s access rights and constraints. This is in 
contrast to identity certificates, which bind a distinguished name (DN) and a public 
key. Commonly, attribute certificates are issued with short validity periods and do not 
contain a public key value.

Auditor
A person with an end-entity certificate who has access to the auditor features on the 
Administration Server. Auditor tasks include viewing and managing the audit logs.
The RSA Certificate Manager Auditor certificate is signed by the Administrative CA; 
the RSA Registration Manager Auditor certificate is signed by the CA of the 
Registration Manager initial target Jurisdiction.

Audit Log
An XML-encoded tamper-resistant file generated by the Logging Server that details 
the success or failure of all PKI operations for which logging has been configured.

Authentication
Certificates are used to identify the author of a message or entity, such as a web server 
or client. People or applications who receive a certificate can verify the identity of the 
certificate owner and the validity of the certificate. This process is called 
authentication.

Authority Revocation List (ARL)
A list of CA certificates that have been revoked or suspended by a particular CA. You 
can use ARLs to check the status of CA certificates offline.

CA
See Certificate Authority.

CA Certificate
A certificate that identifies a CA. When a CA issues a certificate to a client, a server, 
or other entity, the CA private key signs the certificate. You can verify the signature 
using the public key in the CA certificate. See also root CA.

Certificate
Certificates verify the identity of an individual, organization, web server, or hardware 
device. They also ensure non-repudiation in business transactions, as well as to enable 
confidentiality through the use of public-key encryption. PKI uses three main kinds of 
certificates: CA certificates, server certificates (also referred to as SSL certificates), 
and end-entity certificates.

Certificate Authority (CA)
An entity that issues and manages certificates within a PKI. You create and manage 
CAs using a CA software application, such as RSA Certificate Manager.

Certificate Extension
See X.509 v3 Certificate Extension.
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Certificate Fingerprint
The MD5 of a DER-encoded certificate used to identify a certificate when setting 
LDAP and web server ACL rules.

Certificate ID
A certificate identifier used by RSA Certificate Manager to search for or label a 
certificate in the Secure Directory.

Certificate Management Protocol (CMP)
CMP (RFC 2510) is an Internet standard certificate management protocol that defines 
message syntax and semantics supporting many aspects of certificate creation and 
management. This includes registration, revocation, key update, key recovery, 
cross-certification, and many other features. This protocol provides an alternative to 
web-based certificate enrollment.

Certificate Policy (CP)
The conditions and limitations for the use of a digital certificate.

Certificate Profile
A set of extensions along with rules, constraints, and default values for the fields of 
the associated extensions. They are used in the vetting process, as well as to constrain 
and/or validate the information being entered into the certificate extensions.

Certificate Request Syntax (CRS)
CRS, Internet PKI Certificate Request Syntax, specifies an interface to public-key 
certification products and services based on PKCS #7 and PKCS #10. A small number 
of additional services are defined to supplement the core certificate request service. 
Current industry practice regarding the use of PKCS #7 and PKCS #10 is also 
documented for the benefit of the Internet community. In general, the use of PKCS #7 
in CRS is aligned to the Cryptographic Message Syntax (CMS) (RFC 2630), which 
provides a superset of the PKCS #7 syntax.
The above definition and further information is available at 
www.ietf.org/proceedings/98aug/I-D/draft-ietf-smime-crs-00.txt.

Certificate Revocation List (CRL)
A list of revoked and suspended certificates (CA or end-entity) for a particular CA. 
You can use CRLs to check the status of certificates offline. See also Complete CRL 
and Delta CRL.

Certification Practice Statement (CPS)
A CPS defines an organization’s security policies for the issuance and management of 
certificates.

Client Certificate
See End-Entity Certificate.

Complete CRL
A list that contains the serial numbers of certificates that a CA has revoked or 
suspended.

CRL
See Certificate Revocation List.
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CRL Server
A virtual web server host that is a component of the RSA Certificate Manager Web 
Server. The CRL Server is used by Certificate Manager as a publishing site for CRLs 
and ARLs for HTTP-based CRL and ARL retrieval respectively. It is not 
SSL-enabled.

Cross-Certificate
A certificate issued by one CA to another CA that allows users to determine the 
trustworthiness of certificates issued by the other CA. 

Cryptographic Provider
The library the RSA Digital Certificate Solution product uses for private-key 
cryptographic operations (such as key pair generation and digital signatures). The 
method is either software-based or hardware-based.

Data Encryption Standard (DES)
A National Institute of Standards & Technology (NIST) standard for secret key 
cryptography that uses a 56-bit key. DES is based on an IBM algorithm that was 
further developed by the U.S. National Security Agency. It is a block cipher, which 
breaks text into 64-bit blocks before encrypting it. There are several DES encryption 
modes.
DES encryption and decryption are very fast and widely used. The secret key may be 
used repeatedly, or it can be randomly generated for each session, in which case the 
new key is transmitted to the recipient using a public key cryptography method such 
as RSA. For more information, see the standard at 
http://csrc.nist.gov/publications/fips/fips46-3/fips46-3.pdf.

Digital Signature Algorithm (DSA)
The algorithm used in the Digital Signature Standard (DSS) created by the U.S. 
government. For more information, see the standard designation FIPS 
186-2+ChangeNotice at 
http://csrc.nist.gov/publications/fips/fips186-2/fips186-2-change1.pdf.

Directory
LDAP-based directories are databases that can be used to search for and retrieve 
attribute-value pairs. Directories can be configured to use (or support) authentication 
and access control protection. The schema of a directory describes the objects in the 
directory. The Secure Directory schema defines objects that support PKI.

Distinguished Encoding Rules (DER)
An ASN.1 encoding standard used for signature calculation for end-entity certificates 
and revocation lists (that is, CRLs, delta CRLs and ARLs). Also known as Binary.

Distinguished Name (DN)
The combination of attributes in a certificate forms the certificate DN. The following 
attributes are the most commonly used attributes:
• Common Name
• User ID
• E-mail Address 
• Organizational Unit
• Organization
• Locality
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• State or Province
• Country
• Domain Component
To avoid potential problems, all CAs in the PKI, including trusted CAs, should have a 
unique DN.

Elliptic Curve Cryptography (ECC)
A form of public key cryptography based on elliptic curve mathematics. ECC keys 
can be smaller than other keys while still providing the same degree of protection. 
Because of their smaller size, ECC computations tend to take less time and resources. 
These factors make ECC an attractive choice for systems such as embedded devices or 
smart cards, where resources such as RAM and CPU power can be severely 
constrained.

Elliptic Curve Digital Signature Algorithm (ECDSA)
The Digital Signature Algorithm (DSA) standard implemented using elliptic curve 
cryptography (ECC).

Elliptic Curves A and B
Elliptic curves A and B are the types of ECC curves that are supported in 
RSA Certificate Manager. For further information, see the IEEE standard P1363, 
“Standard Specifications for Public Key Cryptography.”

End-Entity Certificate
A certificate issued to an entity that cannot itself issue certificates (that is, the entity is 
not a CA). Because the entity that requests such a certificate is sometimes referred to 
as the client, end-entity certificates are sometimes called client certificates.

End User (or End-Entity)
An individual, group, or organization that either requests or holds an end-entity 
certificate. An end user can also be an individual who requests an end-entity 
certificate for a hardware device (such as a router), a server, a software application, or 
a piece of code. An end user that requests a certificate is sometimes called a requestor. 
An end user that is issued a certificate is sometimes called a certificate owner, 
certificate subject, or end-entity. An end user that relies upon someone else’s 
certificate to verify that person’s identity is sometimes called an end user, certificate 
user, or relying party.

Enrollment Server
A virtual web server host that is a component of the RSA Certificate Manager or 
Registration Manager Web Server. The Enrollment Server offers a 
server-authenticated site where public users (clients) can make certificate requests, 
retrieve issued certificates, and download CA certificates. The Enrollment Server has 
limited access to the Secure Directory Server.

Enterprise
An organization that uses computers and applications. In general use, this term is 
applied to businesses or organizations that operate on a large scale. Applications that 
are designed for these organizations are often referred to as enterprise applications.

Entity
A person, organization, or device (such as a router). In a PKI, an entity may be thought 
of as anything you can issue a certificate to.
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Extended Validation Certificate
A certificate issued to a web site so that its users can confirm the identity of the entity 
that controls the web site. EV certificates must meet the requirements in Guidelines 
for Extended Validation Certificates, established by the CA/Browser Forum. For more 
information, go to the CA/Browser Forum web site at 
http://www.cabforum.org/documents.html.

Extension
See X.509 v3 Certificate Extension.

FASC-N
FASC-N is the Federal Agency Smart Credential Number, which uniquely identifies 
each Personal Identity Verification (PIV) card. It is part of the Cardholder Unique 
Identification file (CHUID) and is the primary identification string used on all 
government issued credentials. For more information, see the standard at 
http://csrc.nist.gov/publications/fips/fips201-1/FIPS-201-1-chng1.pdf.

FIPS 140-1 Level 2 & 3
FIPS 140-2 Level 2 & 3

A standard developed by the National Institute of Standards and Technology (NIST) 
for implementation of cryptographic modules. Level 3 provides greater security than 
Level 2.

Firewall
A system designed to prevent unauthorized access to or from a private network.

Fully Qualified Domain Name (FQDN)
The full name of a system, consisting of its local hostname and its domain name. For 
example, “venera” is a hostname and “venera.isi.edu” is the FQDN. 

GOST
GOST (Gosudarstvenii Standart) refers to the Russian Government Standard for 
cryptographic protection for Data Protection Systems. Software products exported to 
Russia require the use of the GOST algorithm in order to be offered for sale. 
The GOST algorithm is supplied through the use of the Crypto-Pro Cryptographic 
Service Provider (CSP) v1.2.

Hardware Security Module (HSM)
The module that performs cryptographic functions and stores cryptographic keys in a 
secure fashion.

Hypertext Transfer Protocol (HTTP)
A set of rules for exchanging files (text, graphic images, sound, video, and other 
multimedia files) on the World Wide Web. 
Web browsers are HTTP clients that send requests to server machines. Users enter 
page requests by either typing a URL or clicking a hypertext link. The browser builds 
an HTTP request for the user and sends it to the Internet Protocol (IP) address 
indicated in the URL. The HTTP daemon in the destination server receives the request 
and, after any necessary processing, returns the requested page. See also HTTPS.

HTTPS
HTTP over an SSL/TLS connection.
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Identity Certificate
A certificate that links a public key value to a real-world entity such as a person, a 
computer, or a web server. Server certificates, CA certificates, and most end-entity 
certificates are all examples of identity certificates.

Issuing
The act of signing a certificate request with the private key of a CA to create a 
certificate.

Jurisdiction
A Jurisdiction is a set of configurations that define the form and content of the 
certificates issued under it, the life cycle management of those certificates, and the 
look and feel users will find when enrolling.

Key Pair
A public key and a private key associated with an entity that needs to authenticate its 
identity electronically or to sign or encrypt data. The public key is published, and the 
corresponding private key is kept secret. You can only decrypt data encrypted with the 
public key with the private key.

Key Recovery
The process of recovering a private decryption key from a secure archive for the 
purposes of recovering data that has been encrypted with the corresponding 
encryption key.

Key Recovery Operator (KRO)
An entity involved in the recovery of private keys through the use of tokens or smart 
cards. A configurable minimum number of KROs are required to access the hardware 
security module (HSM) individually within a specific time period.

Key Size
The size (in bits) of the key pair. A larger key size provides greater security. 
RSA Certificate Manager and RSA Registration Manager supports 1024, 2048, and 
4096 bit keys.

LDAP Directory
An LDAP-based directory is a database. You can search for and retrieve 
attribute-value pairs. You can configure directories to use (or support) authentication 
and access control protection. The schema of a directory describes the objects in the 
directory.

LDAPS
LDAP over SSL/TLS Connection.

Lightweight Directory Access Protocol (LDAP)
The standard Internet protocol for accessing directory servers over a network. LDAP 
is a “lightweight” (smaller amount of overhead) version of Directory Access Protocol 
(DAP), which is part of X.500, a standard for directory services in a network. There 
are two currently supported versions, LDAP versions 2.0 and 3.0. See also LDAPS.

Load Balancer
A software or hardware product that routes incoming data to one of a number of 
possible resources or applications.
Glossary 101



RSA Registration Manager 6.9 Installation Guide
Logging Server
The Logging Server records PKI events for one or more client applications such as the 
Secure Directory Server. Event data is stored in a signed log file that can be verified 
and exported in XML or comma-separated value format.

Message Digest 5 (MD5)
An algorithm for creating a cryptographic hash (or “fingerprint”) of a message or data. 
MD5 can also refer to the value resulting from the application of the MD5 algorithm. 
A certificate MD5 value is unique to that certificate, and is often used to identify a 
certificate when setting LDAP and web server ACL rules.

MofN
A process of key encryption where a private key is split into N shares to be stored on a 
hardware device such as a token. M can be any value between 1 and to N. M shares 
are required to reconstitute the private key.

Nickname
A user-friendly character string that uniquely identifies a CA or CRL signer.

Non-repudiation
A concept that prevents the author of a message from denying having created that 
message at a later date (that is, repudiation cannot occur). Digital signatures help 
ensure the non-repudiation of transactions.

OCSP
See Online Certificate Status Protocol.

OCSP Client
The entity that issues a certificate status request to an OCSP responder. The OCSP 
client suspends acceptance of the certificate until the responder returns the certificate 
status.

OCSP Request
A client issues an OCSP request to obtain the status of a certificate. The client 
suspends acceptance of the certificate until it receives an OCSP response.

OCSP Responder
The OCSP Responder accepts certificate status requests from OCSP-enabled clients, 
looks up a certificate status in a CA database, and responds with the current certificate 
status.

OCSP Response
Once an OCSP response is received by the client who issued the OCSP request, the 
certificate is accepted by the client.

Online Certificate Status Protocol (OCSP)
A protocol, defined in RFC 2560, that enables applications to check the status of a 
certificate every time the certificate is used. If you configure your PKI to use OCSP, 
CRLs are unnecessary for end users.

Online Validation
Online validation occurs when a CA can be queried directly about the validity of a 
certificate every time the certificate is used. 
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Operator Card Set (OCS)
A card set within the nCipher security world that is used to generate, protect, and 
access the private keys created within it.

Persistent
If an OCS is made persistent, the keys protected by a member card remain in the HSM 
after the card has been removed from the card reader. By default, an OCS is 
non-persistent. An OCS can be made persistent or non-persistent at creation only.

PIV NACI
PIV NACI is Personal Identity Verification National Agency Check with Written 
Inquiries. Identity credentials issued to individuals without a completed NACI can be 
electronically distinguishable from identity credentials issued to individuals who have 
a completed investigation, based on the PIV NACI indicator extension.

PKCS #7
The Cryptographic Message Syntax Standard. For more information on the standard, 
go to www.rsa.com/rsalabs/pkcs/pkcs-7/.

PKCS #9
The Selected Attribute Types Standard. For more information on the standard, go to 
www.rsa.com/rsalabs/pkcs/pkcs-9/.

PKCS #10
The Certification Request Syntax Standard. For more information on the standard, go 
to www.rsa.com/rsalabs/pkcs/pkcs-10/.

PKCS #11
The Cryptographic Token Interface Standard. For more information on the standard, 
go to www.rsa.com/rsalabs/pkcs/pkcs-11/.

PKCS #12
The Personal Information Exchange Syntax Standard. For more information on the 
standard, go to www.rsa.com/rsalabs/pkcs/pkcs-12/.

PKIX
The evolving Internet Engineering Task Force (IETF) standard for PKI using X.509 
certificates. For more information on the standard, go to 
www.ietf.org/html.charters/pkix-charter.html/.

Privacy Enhanced Mail (PEM) format
PEM was originally created to provide secure e-mail services on the Internet, but it 
became too unwieldy for widespread use. Now, “PEM format” usually refers to the 
Base64 encoding algorithm that was part of the PEM proposal.
PEM encoding is useful for presenting binary data in a text-readable form. (For 
example, to allow you to copy and paste data between applications.) Also known as 
Base64.

Private Key
The private part of a public-key key pair. With RSA Certificate Manager and 
RSA Registration Manager, private keys are generated on the client whenever a 
certificate request is madePrivate keys must be securely stored to prevent 
unauthorized access and accidental deletion.
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A digital signature involves encrypting a message digest with a private key and allows 
anyone with the corresponding public key to decrypt the message digest to be certain 
of who sent the message and that it has not been tampered with.
You can decrypt information encrypted with a public key with the corresponding 
private key.

Public Key
The public and widely distributed part of a public-key key pair. For example, a 
certificate contains information about the certificate subject, the certificate signer, and 
a public key value. In general, you can only decrypt information encrypted with a 
public key with the corresponding private key.

Public-Key Cryptography Standards (PKCS)
A set of standard protocols developed by RSA for making secure information 
exchange possible. The standards include RSA encryption, password-based 
encryption, and cryptographic message syntax. For more information on the standard, 
go to www.rsa.com/rsalabs/pkcs/.

Public Key Infrastructure (PKI)
A system for publishing, distributing, and managing the public key values used in 
public key cryptography. All PKIs involve issuing public key certificates to 
individuals, organizations, and other entities and verifying that these certificates are 
valid.

Qualified Certificate
An end-entity certificate whose primary purpose is to identify a person with a high 
level of assurance in public non-repudiation services. For more information on the 
standard, go to www.ietf.org/rfc/rfc3739.txt?number=3739.
For more information on the European Telecommunications Standards Institute 
(ETSI) Technical Specification (TS) for the use of Qualified Certificates, No. 101 862 
v1.2.1, go to www.etsi.org/.

Registration Authority (RA)
An entity that performs registration services on behalf of a CA. RAs work with a 
particular CA to vet requests for certificates that will then be issued by the CA.

Revocation
Revoking a certificate invalidates it and removes all of its privileges in the PKI. 
Revocation is necessary if the CA administrator wants to invalidate the certificate 
before it expires. Administrators revoke certificates by marking them as invalid in the 
Secure Directory. Users of the PKI are notified of the revoked status a certificate 
during online validation or with revocation lists.
Revoking a CA invalidates the CA certificate and removes all the PKI privileges of 
the CA. Revoke a CA only if you have organizational-based security concerns and 
only as a last resort.

Revocation List Signer
An entity that signs complete CRLs, delta CRLs, and ARLs for a specific CA. An 
Administrator can designate a particular entity or the CA itself. 

Rivest-Shamir-Adleman (RSA)
A highly secure cryptography method created by the three founders of RSA: 
Professors Ronald L. Rivest, Adi Shamir, and Leonard M. Adleman.
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RSA uses a two-part key. The private key is kept by the owner; the public key is 
published. Data that is encrypted using the recipient’s public key can only be 
decrypted by the recipient’s private key, and vice-versa.
The RSA algorithm is computation intensive. Therefore, it is often used to create a 
digital envelope, which holds an RSA-encrypted symmetric key (often DES) and 
symmetric key-encrypted data. This method encrypts the secret symmetric key so that 
it can be transmitted over the network, but encrypts and decrypts the actual message 
using the much faster symmetric key algorithm.
The RSA algorithm is also used for authentication using digital signatures. In this 
case, the sender’s private key is used for signing, and the sender’s public key is used 
for verification. The RSA algorithm is also implemented in hardware. As RSA chips 
get faster, RSA encoding and decoding will add less overhead to the operation.

Root Bind
Clients normally identify themselves when binding (connecting) to an LDAP server 
(anonymous connections are also possible). Access control rules allow access to be 
granted to the directory information tree on the basis of the client's identity. A client 
may connect with root privileges if it identifies itself as the root user and has the 
necessary credentials to authenticate itself as such.
Clients binding as root are not subject to the normal access control rules and may read 
or write to any part of the directory information tree.
To bind as root, a client must know the name of the root user. In addition, it must have 
the corresponding password, or a specific X.509 client certificate from which the root 
name can be derived. 

root CA
A CA whose certificate is self-signed (that is, the issuer and the subject are the same). 
A root CA is at the top of a hierarchy.

SCEP Server
A virtual web server host that implements the Simple Certificate Enrollment Protocol, 
and provides a means for clients (primarily IPSec hardware and software agents) to 
obtain CA certificates and revocation lists, and to enroll for end-entity certificates. 
The SCEP Server is used by RSA Certificate Manager both as an enrollment 
mechanism and as a repository for end-entity certificates to be retrieved by routers and 
standalone devices with little non-volatile memory. It is not SSL-enabled. Security 
and authentication are enforced through the use of signed and encrypted PKCS #7 
messages. The SCEP Server has limited access to the Secure Directory Server.

Schema
A schema describes an object and its attributes in LDAP directories such as the 
RSA Certificate Manager or RSA Registration Manager Secure Directory.

Secure Directory Server
A secure LDAP directory that stores all of the information for your PKI. The Secure 
Directory publishes certificates and is used as a read-only repository for public users.

Secure Hash Algorithm (SHA-1)
An algorithm developed by the U.S. National Institute of Standards & Technology 
(NIST). SHA-1 is used to create a cryptographic hash (or “fingerprint”) of a message 
or data. SHA-1 is considered to be somewhat stronger than MD5. SHA-1 is defined in 
FIPS Publication 180-2, the Secure Hash Standard (SHS).
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Secure Hash Algorithm (SHA-256)
An algorithm developed by the U.S. National Security Agency (NSA). SHA-256 
operates in the same manner as MD5 and SHA-1 and creates a 256-bit cryptographic 
hash of a message or data. SHA-256 is considered to be stronger than SHA-1.

Secure Hash Algorithm (SHA-384)
An algorithm developed by the U.S. National Security Agency (NSA). SHA-384 is a 
variant of SHA-512 and creates a 384-bit cryptographic hash of a message or data. 
SHA-384 is considered to be stronger than SHA-1.

Secure Hash Algorithm (SHA-512)
An algorithm developed by the U.S. National Security Agency (NSA). SHA-512 is a 
variant of SHA-256 and creates a 512-bit cryptographic hash of a message or data. 
SHA-512 is considered to be much stronger than SHA-1.

Secure Sockets Layer (SSL)
A protocol layer created by Netscape to manage the security of message transmissions 
in a network. Security is achieved through encryption. “Sockets” refers to the sockets 
method of passing data back and forth between client and server programs in a 
network or between program layers in the same computer.

Secured Electronic Information in Society (SEIS)
The name of a non-profit organization in Sweden, working on implementing a 
common and open infrastructure to make communications in an open network, such as 
the Internet, secure. SEIS, founded in 1995, has developed a concept and the strategy 
to implement IT security for commercial use on a worldwide scale.

Security World
A security world consists of at least one hardware module, a set of smart cards, and 
encrypted data stored on a computer.

Server Certificate
An end-entity certificate issued to a server. Servers present their certificates to web 
browsers so browsers can verify (authenticate) the identity of the server. Server 
certificates are sometimes called SSL or TLS certificates.

Signing
A process by which a digital signature is affixed to a file, document, or certificate as 
proof that it has not been tampered with and that the author is who claims to be the 
author.

Simple Certificate Enrollment Protocol (SCEP)
A PKI communication protocol that supports the secure issuance of certificates to 
routers and other standalone devices in a scalable manner by using PKCS #7 and 
PKCS #10. 

S/MIME
Microsoft and Netscape include S/MIME in the latest versions of their e-mail clients. 
Other vendors of message products also endorse S/MIME.
MIME itself, described in the IETF standard RFC 1521, defines the structure of an 
electronic message. S/MIME allows the message body to include encryption 
information and a digital certificate. S/MIME has extended the syntax provided in 
PKCS #7. For more information on the standard, go to 
www.ietf.org/html.charters/smime-charter.html.
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SSL Client Authentication
The process whereby a server authenticates a client by verifying the end-entity 
certificate presented by the client during SSL operations.

SSL-LDAP
See LDAPS.

SSL Server Authentication
The process whereby a client application authenticates a server by verifying the 
certificate chain presented by the server during SSL operations, starting with a CA 
trusted by the client.

Status
The validity of a certificate: active, reinstated, revoked, or suspended.

Suspension
The process of marking a certificate as temporarily invalid. The end user presenting 
the suspended certificate is denied access where the certificate previously allowed 
access. Reinstating a certificate returns all removed PKI privileges.
Suspending a CA certificate marks it as temporarily invalid and removes all PKI 
privileges of the CA. Reinstating a CA certificate returns all removed PKI privileges.

System CA
The CA created during installation of RSA Certificate Manager to issue the server 
certificates for the System Web Servers and the certificates for accessing back-end 
functionality, either through the Web Servers, the Logging Server, or RSA Certificate 
Manager API applications. The System CA also signs the Administrative CA 
certificate. The System CA should not be used after installation except to re-sign the 
certificates it issued during installation.

System Log
An operating system-specific file that RSA Certificate Manager or RSA Registration 
Manager uses to record systemic events not related to regular operations or 
configuration changes.

Trace Log
A file containing information suitable for debugging purposes.

Transport Layer Security (TLS)
Internet protocol that provides privacy between server and client. TLS ensures that no 
third party may eavesdrop or tamper with any message. TLS is the successor to SSL; 
however, they are not interoperable.

UTF-8 Encoding
An ASCII compatible multibyte Unicode and UCS encoding, used by current 
browsers, Java and Plan 9.

Validation
The process of verifying that a certificate is valid. Validation can occur online or 
through the use of revocation lists.

Vetting
The process of reviewing a certificate request, verifying the information provided in it, 
and determining if a certificate should be issued. RAs may be used to vet certificates 
for CAs in large PKIs.
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Vettor
A person with an end-entity certificate who has vetting access to one or more 
Jurisdictions of one or more CAs through the Certificate Operations Workbench. 
Vettors are the trusted individuals within an organization that review requests for 
end-entity certificates. Vettors determine whether the RSA Certificate Manager or 
RSA Registration Manager should issue a certificate. Vettors also manage the status of 
certificates after they are issued.
The Certificate Manager Vettor certificate is signed by the Administrative CA; the 
Registration Manager Vettor certificate is signed by the CA of the Registration 
Manager initial target Jurisdiction.

Web of Trust
In an unstructured PKI, if enough CAs issue certificates that bind a particular name to 
a particular key, then another CA can accept that binding based on the trust that exists 
between the other CAs.

Web Server
An Apache-based server that is the primary interface to RSA Certificate Manager and 
RSA Registration Manager.

X.509
An International Standards Organization (ISO) standard that describes a basic 
electronic format for digital certificates.

X.509 v3 Certificate Extension
Certificate extensions, including extensions for PKIX, SET, and SSL. The 
RSAValidation Solution supports X.509 v3 that conform to version 3 of the X.509 
standard and specify additional constraints or capabilities on the certificate subject.

X-Parse
A template-based HTML extension language. It is used to compose web-based 
PKI-enabled applications.

XUDA Template
A XUDA template is a scripted HTML file. Each template combines regular HTML 
with scripting tags from the RSA X-Parse server-side scripting language, in much the 
same way that Java Server Pages combine regular HTML with JSP scripting tags. The 
X-Parse tags embedded in the HTML are parsed by the RSA Certificate Manager and 
RSA Registration Manager Web Servers, and the fully formed HTML result is 
returned to the browser.

Xudad
See Secure Directory Server.
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Acronyms

ACL access control list

AES Advanced Encryption Standard

API application programming interface

ARL authority revocation list

ASN.1 Abstract Syntax Notation One

CA certificate authority

CGI common gateway interface

CMP certificate management protocol

CP certificate policy

CPS certification practice statement

CRL certificate revocation list

CRMF certificate request message format

CRS certificate request syntax

CSR certificate signing request

DER Distinguished Encoding Rules

DES Data Encryption Standard

DH Diffie-Hellman

DIB directory information base

DSA Digital Signature Algorithm

ECC elliptic curve cryptography

ECDSA Elliptic Curve Digital Signature Algorithm

ETSI European Telecommunications Standards Institute

EV Extended Validation

FQDN fully qualified domain name

GAL Global Address List

GLB greatest lower bound
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GOST Gosudarstvenii Standart (Russian Equivalent of ANSI)

GUI graphical user interface

HSM hardware security module

HTML Hypertext Markup Language

HTTP Hypertext Transfer Protocol

HTTPS Hypertext Transfer Protocol (over an SSL connection)

IDS interoperability datasheet

I18N Internationalization

IEEE Institute of Electrical and Electronics Engineers

IETF Internet Engineering Task Force

IME Input Method Editors

IPSec IP Security Protocol

ISO International Standards Organization

ITU/CCITT International Telecommunication Union

KRO Key Recovery Operator

LDAP Lightweight Directory Access Protocol

MD5 Message Digest 5

MSIE Microsoft Internet Explorer

NES Netscape Enterprise Server

OCS Operator Card Set

PCI Peripheral Component Interconnect

PEM Privacy Enhanced Mail format

PIN personal identification number

PKCS Public-Key Cryptography Standards

PKI public key infrastructure

PKIX Public Key Infrastructure (X.509)

POP proof of possession

RA registration authority

RAM random access memory
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RSA Rivest-Shamir-Adleman

RSA-PSS RSA - Probabilistic Signature Scheme

S/MIME Secure Multi-Purpose Internet Mail Extensions

SCEP Simple Certificate Enrollment Protocol

SDK software development kit

SEIS Secured Electronic Information in Society

SHA-1

SHA-256

SHA-384

SHA-512

Secure Hash Algorithms

SPKAC Signed Public Key and Challenge

SSL Secure Sockets Layer

SSL-LDAP Lightweight Directory Access Protocol over a Secure Sockets 
Layer connection

UCS Universal Character Set (the superset of all other character sets)

URI Uniform Resource Identifier

URL Uniform Resource Locator

UTF-8 Universal Transformation Format

VPN virtual private network

XML Extensible Markup Language
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nCipher smart cards, 67–75
Index 113



RSA Registration Manager 6.9 Installation Guide
P
post-installation tasks, 34
pre-installation checklist, 16

R
RM Administrative certificate, 52

S
SafeNet Luna tokens. See Luna tokens
SCEP Server

definition, 52
issued certificates, 54

Secure Directory Server
definition, 52
security configuration, 58–61

server configuration, 51–52
server configuration (figure), 51
Simple Certificate Enrollment Protocol. See 

SCEP Server
system requirements, 9–13

Linux, 10
Solaris, 10
supported browsers, 11
Windows, 9

T
target CA installation, definition, 15
target Jurisdiction, definition, 15

U
uninstalling, 87–89

on Linux, 89
on Solaris, 89
on Windows, 87

upgrading, 39–49
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